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Introduction

System overview

Welcome to the Blink Mailer Manual.

This first chapter will explain what Blink Mailer is used for and give you a basic
overview of how it works.

What is Blink Mailer?

Blink Mailer is used for sending email newsletters, announcements and
notifications. It is designed to send a single message (a campaign), by email to
large numbers of recipients (subscribers).

You organise your subscribers into listsand you can import email
addresses from your email account, online shop, blog or database. You can
also import attribute data, for example, subscriber name, city or shoe size.

Campaigns are composed in a web interface and can be personalised for each
subscriber. Personalisation is done with the use of placeholders which display
attribute data within the text of the emails, as well as unique links that allow
subscribers to join or leave lists easily. You can use plain text, HTML and
templates.

Once a campaign has been sent, Blink Mailer will show statistics about it. This
will include opens/views (who read the campaign), clicks (who clicked which
link in the campaign) and bounces (which addresses were incorrect and
delivery failed). Bounced mails and unsubscribes are automatically removed
from the system, which will benefit future delivery of campaigns.

Blink Mailer uses phplist which is Open Source software and it is published
under the AGPLv3 licence.

A quick tour of Blink Mailer

Blink Mailer has an attractive web interface and a wealth of features to
explore.

S BLINK
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Campaigns

Composing and sending campaigns is achieved by following a step by step
process.

Canfy  Infa
E¥HELF
G HaIATIEH
Daskboan
Corrirn halp
Ahouk phplLis!
content P HENT Sl
0f &
i\
RuUbjRed @ Sanc a campalgn
o sukject) —_——————

Lisi of campagns
From lina L’“:'

AL ME S doma . L
Recehmoy Wismen
content Zane a carmpalan
Send awebpage ® Corrpose message ) TEESETE T EEEEm e T
- : ¥ P Dashbosrd
Compose mesane @
Gl R BRI Z DiEE ie = = miE e [ Sene o campagn
=rthing

Marage campalgn trmElatas

Seanch subscrbams

EnRGLEH b

Subscribers

In Blink Mailer you upload your contacts once and the information is ready to
use every time you send a campaign.

IMPORT EMAILS

Please choose one of the import method

g copy and paste list of emails
’
I import by uploading 2 file with
2y p . Y up !9
emails
.
b : '
& import by uploading a CSV file
with emails and additional data
’

You can group subscribers into one or more lists

A BLINK
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SUBSCRIBER LISTS

| UNCATEGORISED i Categorise isis i Add a lis1
3 Lists
Lists
LISTS WEMBERS FUELIC DRDER
All subseribers o480 (1) & |

o) 's) 0) 5

= Y -
)8 0] &

Lives in USA 237 9_,_| = 0
®) %) 0) 5]

Lives in rest of world urs @ | [ 9

EE*AJEJ-E_J

SAVE CHANGES

Add alist

Simply choose which list you want to send to when you create your campaign.

SEND A CAMPAIGN

lists

= Please selact the lists you want to sand your campaign to:

= LJAllLists

= [ Al Active Lists

= ¥ Lives in rest of world (Private list)
« [JLives in USA (Private list)

« [Jtest (Private list)

Save as draft Save and continue editing

sack | nexT

139 f"?fj. B I_i N K
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Subscribe pages

Subscribers can sign up to your lists though subscribe pages, which are fully

customisable.

Subscribe to our newsletters
FECUIPED % APE MAHED PED

Email address

Canirm your email address

# | preferio receive emails in Ted format

'What type ofpets to you hawe?
'Which ethical issues are you passionate about?
Last name

First name

Subscribe to the selected newsletters

Unsubscribe

& pholist

..and can be integrated with your website.

)
e dental...

Newsletter

Enter your email

Subscribe to The Ethical |

Fets Gazette

Previous Editions

8th Dec 12, 16th Jan 13
7th Feb 13, 9th Mar 13
31st Mar 13, 16th May 13
15th July 13, 2nd Sept 13
9th Sept 13, 2nd Oct 13
11th Oct 13, 17th Oct 13
Gth Mov 13

Four Seaso
Parasitic

Benevo Ve
Cat Food

s BLIN K
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Campaign Statistics

You can view basic and detailed statistics about every campaign you send to
help you learn more about your subscribers.

Download as CSV file

SENT ENCS FWDS VIEWS
Puuurfect: 50% off © .. 20/8/14) 621 ] ] 156

DATE: 15 AUG 2014 | RATE: 253.12 %

What does Blink Mailer not do?

Blink Mailer is a one-to-many email program. It cannot easily be used to have

"email conversations" many-to-many as you might do on software such as
mailman.

AFFORDABLE MARKETING SPECIALISTS
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® Mail File Edit View Mailbox Message Format Window Help
ao0e May website special — Trash

admin 18 May 2015 at 2:17 AM
To: warren@ prop2000.co.za Hide Datauls

May website special

MAY WEBSITE SPECIAL - 10% off all sites!

Any websites ordered before the end of May will receive a 10% discount off the design - CLICK HERE to fiad oot more

Dear Warren

Do you need a new website or do you need to give your current
site a fresh, updated look?

Do you need reliable hosting for your existing website & email
addresses?

Let SA Flyers make it easy for you with our packaged solutions.

Hosting Prices
Why host your website and email with SA Flyers?

» 3 Package options to suit your business needs

« Free domain registration and annual renewal

« 24 Hour 3rd party technical support

« Guaranteed 99.7% up time

= Full control of domain tools via konsoleH (includes email changes and acoess to statistics)
Hosting Package Options

Basic Business |Advanced Business |Email Marketing

Monthly Cost R100 incl VAT R240 incl VAT R450 incl VAT
Free Domain Registration v v v
Free Domain Annual Renewal |3 v v
Traffic Unlimited Unlimited Unlimited
Disk Space Sgb 150b 15gb

SA Flyers started their newsletter in 2009 when they launched their website: a
newsletter has always been integral to their business model. Initially they used
proprietary hosted solutions which they found too expensive. They then tried
using a 'homegrown' solution but they soon outgrew its capabilities. For them

Blink Mailer was the happy medium. SA Flyers has been using Blink Mailer
since 2012.

A BLINK
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Medium Business

Attila Fodor (FineCutBodies) is a musician, producer and a former developer
(of playstation games!).

He runs an indie record label which has had more than 60 releases and
hundreds of gigs since 2000. He goes on world tours and has aired over 700
hours of radio content in the last 15 years. He also teaches at the Budapest
School of Music Technology, running a regular class on digital technology and
basic sound design paradigms.

w .HIIHL_I\JL-‘-.-'-..-'. (|

Welcome Users Development Documentation Trz

Fine Cut Bodies

@finecutbodies

acive 2weeks, Gdaysago
1

Activity  Profile  Groups 0

I About Me
Name Fire Cut Bodies
Iy main dailty routing is to hide music behind noise, but coming
demo scene coder background, I'm big fan of audio/visual codin
Bio graphics, sound design, music, audio programming, games and

FineCutBodies started a newsletter when he founded his record label in 2001.
He began by pasting email lists into the Bcc line in his mail software. When the
list started to grow he tried a few different newsletter programs.

In 2014 he started searching for a newsletter software which could provide
bespoke functionality and smooth website integration. As an audiovisual coder
and video game developer, FineCutBodies has used his coding experience to
customise Blink Mailer to his needs.

pg 10



Fine Cut Bodies: Sherman's Travel SFX pack [FCBSD03]

Fine Cut Bodies

Sherman's travel
sample pack IFfB D83

Free download

Your name Enter emall

Send me the link!

* By submitting your email address, you agree to receive futurs email updates from me.

2 Get notified by emaill

sound, computer graphics and algorithms."

ATOROABLE MARKETING SFECIALISTS pg 11
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Small Business

Happy November!

W hiave had a fabulous few weeks at the

and Manchesler Vegan [airs. We have mel IlLB[dH_‘f l.lwusauds ol
ethically minded, sco-Iriendly people in such a short space of time -
it'a been humbling, exciting and inspiring to say the least!

Iis time of year is so busy for us hecawse November is World \eqan
Month. It's a great tme to celebrate every aspect of Veganism and all
Lhe dillerenl people invelved - [rom Lhoss will allelgw:s and healll
problems ko animal weltare activists, via eco-warriors bo raw Eood
qurns, not forgetting Buddhists and Hindus and of course herhivore
pets such as Rabbits and Guinea Pigs... teally, we need more than a
month e At them all in!

W have a special ¥egap Dog Slarter Pack olfer which provides a
great chance tor vou and vour dog to take a 7 day ?

Hawve a great Nosrem ber!

Love IFrom

Anna & Joey

{:.F

.% 'nlurld %

e

) _ﬂ"'h e

e

The BﬂW]nnUﬂ is We now use Hurrah lor the
Coming Triodos World
om Saturday | <o and they have Anna spent last.
ffpplill in te gone week animating

Ethical Pets is an online store which sells Bio/Organic, ecological and fairly
traded pet products.

They began using Blink Mailer to send out a newsletter called The Ethical Pets
Gazette five months after they launched their store, and have now been
running the list for nearly three years.

Ethical Pets

« Publicise the ethical qualities of new products

« Share blog articles about environmental and animal welfare campaigns

 Encourage the feeling of friendship and community present in fairs and
festivals

The Ethical Pets Gazette now has 750 subscribers. Most are customers whose
addresses were exported from online shop software. There is an AJAX sign up
form on their shop front and they sometimes segment their lists to target
specific customer groups, for example, dog owners or cat owners.

Their average open rate is as high as 36%.

-BLINK
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Community Group

The Parliament of South Africa is legally required to inform the citizens of
South Africa about their work. Responsibility for this task falls on the manager
of the Content and Information Unit at Parliamentary Communication Services,
who is mandated to spread this information to as broad a range of readers as
possible.

One of the methods used is the Insession newsletter, which is published on a
monthly basis on their website as a pdf and ebook.

OUR BUSINESS
PARLIAMENT OF PARLIAMENT

Insession August 2014
Online E-Book  PDF

Subscribe to Insession eMewslatter

[EXPLORE PARLIAMENT
OUR BUSINESS OFFICE-BE

Blink Mailer is used to target the audience that wish to receive this newsletter
digitally. Insession is sent to subscribers as an HTML email with links to longer
articles on the government website.

1 Inbox - Info@ethical-pe... __-'. =] eMewsletter vol. 14... = '.\

From insession sinsession@parlisment.gov.zas 11 | % Reply = Forward & Archive @ Junk | 8 Delete
| ubject eMNewsletter vol. 14 Issue § October 2014 12/11/14 14:27
T Sl . Gther Actions ™~

*telebrabing the legacy of freedom theowgh strengthening the link between Padiament and the people®

IHSG‘SSL&(@H

aSession Vel 14 issue § Ociober 2014

Editor's note

1 keeping wilh the constilulional mandale of Sauth Aliex's Parbamenl W engage m alematicnal stairs, nSassion is arad 1
= repoit an the sweading i of the new Membars Yo Sedth Arica's fth Parkament &t tie Pan Afiican Parlament held in

Wi o

Message from the Mational Council of Provinces

| put the guestion

ouarad many
mant

p, Questars azked in Farament recently cov
Wi Az In the orocess of craming the strateglc jlan for €, %
. he tHtth Parlament. The Sinancial Management of g in the
__ Fariament Act obliges the Executive Authorty [ & 5
the Speaker of tha Nabonal Assembly and tha & o

. BLINK
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http://www.parliament.gov.za/live/content.php?Item_ID=3026

B LI NS
Subscribe to our Newsletters — Mozilla Firefox x
& [ 1]
Subscribe to our Newsle... * | ] (T |
parliament.gov.za/lis EERve 2w B 3 » =
OF THE REPUBLIC OF SOUTH AFRICA
etters using the form
Please select the newsletters you want to sign up ta:
. . InSession
Subscribe to the Selected Newsletters
pg 14
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User Manual

This contents of this manual has been written by the phpList community
documentation team, individual volunteers, companies and phpList Ltd staff.
The contents has further been summarised and edited by Warren Eades of
Blink for clients using Blink Mailer.

Aims

This manual will teach you how to use Blink Mailer. It provides real life
examples where possible and chapters are goal oriented. We hope you will
come away from each chapter with inspiration and motivation as well as an
education!

Target audience and assumptions

The manual is aimed at users with average tech skills who are starting at the
beginning with Blink Mailer.

Disclaimer

Software is not static, it continuously changes. Blink Mailer is no different from
other software, in that it is regularly updated to fix issues, add new features
and respond to a changing environment of browsers and internet technology.
This manual attempts to provide you with a guide to how Blink Mailer works,
but the version you are using may be different from what is described here.
The manual should help you to work Blink Mailer in a general way, but you
may nheed to interpret it for your situation to make Blink Mailer do what you
want it to do.

How to use this manual

Most chapters will walk you through a task, with a screenshot for each stage.
It may be that you only require assistance with one aspect of a task, in which
case skip ahead.

Styles

Each level of a menu is signified with a >. If you need to go to Subscribers in
the main menu, and then click Add new in the sub menu, the we would
annotate this as Subscribers > Add new.

AFFOREABLE MARKETING 3RECIAL ara pg 15
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Documentation team
Thanks to all the the following contributors, in no particular order:

Dragonrider, Nikita Lyalin, Paul Mellors, Dan Waterloo, Elisa, Michiel, Mariela,
Orsiris de Jong, Jolo, Lucas Schneider, Guido Hornig, Vedran Vucic, Sylvain,
Andreas Tolfsen, Titano, Charlie Russell, Joseph Morris, Bjérn Balazs,Mindhack,
Alexandru Berendei, Marius, Sam Tuke, Marcela Lopez Levy, kitchm, Rodrigo
and Linda Ainsworth.

Thanks to phplist

phplist is an open source product and is fully integrated into Blink Mailer. A
portion of all profits are contributed from Blink to phplist in order to support
past and future developemnets.

8. BLINK
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http://phplist.org/our-team/redlinda5/
http://phplist.org/our-team/rata/
http://phplist.org/our-team/kitchm/
http://phplist.org/our-team/marcela/
http://phplist.org/our-team/samtuke/
http://phplist.org/our-team/clorith/
http://phplist.org/our-team/alexberendei/
https://phplist.org/our-team/mwastling/
http://phplist.org/our-team/bjoernbalazs/
http://phplist.org/our-team/sirromeoj/
http://phplist.org/our-team/charlizegirl/
http://phplist.org/our-team/titano/
https://phplist.org/our-team/sylvain/
https://phplist.org/our-team/veki/
https://phplist.org/our-team/veki/
https://phplist.org/our-team/actxcellence/
https://phplist.org/our-team/lschneider94/
https://phplist.org/our-team/moderndayfreak/
http://phplist.org/our-team/deajan/
http://phplist.org/our-team/mariez/
http://phplist.org/our-team/michiel/
http://phplist.org/our-team/danwaterloo/
http://phplist.org/our-team/paulmellors/
http://phplist.org/our-team/tinman321/
https://phplist.org/our-team/dragonrider/

| BasicUsage e C NG

Basic Usage

Logging in

Blink Mailer when you are logged out

When you are not logged in, any page you visit in your Blink Mailer installation
will prompt you to enter your username and password. For example, if I visit
my dashboard, which usually resides at my-domain.com/lists/admin:

i) phpList :: phplList Cle... * | 4

€ D e L =B S e N o [lists/admin/

I would see my login prompt, marked below in red.

A BLINK
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Basic Usage

How to log in to Blink Mailer

To log in, enter the username in the Name: box and password in the
Password: box, then click Continue. The default username is admin, however,
your system administrator may give you a more personalised

login.
MName:
@ admin
e Fassword:
Continue

When you have successfully entered your username and password you will see
the page you were trying to access. In this case, the Dashboard.

BLINK
Subscribers Cormpaigns Statistcs  Infa
BN NaveTON
i Ciaghboard
= Main e
Hegp
About ghplist
E Liog cut
Stat or conbriue @ campaign .
Serd A canpag
REcsnTLy MISTED
bashbaard
.‘ Wiew curmant campaizes Irnpet susscribers from texl
kanage canosignm e e
—_— Import &mais
]
i Search, adit and add subssribers EMGLISH
et i
IIII Wiew sEtistics
WiV B CE
A
v Listand user funclions
¢ Campaign funclions
v Plugins

It is a good idea to bookmark your dashboard and use it as the primary way to

access your Blink Mailer. Depending on your configuration, your dashboard

might look a little different, for example there might be more items on your
menu bar.

BLINK

AFFORDABLE MARKETING SPECIALISTS
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How to log out of Blink Mailer

The Logout button will always display in the top right of your installation.

Remember to logout when you are not using Blink Mailer: your installation
contains the personal data of your subscribers and it is your responsibility to
keep it secure.

LASHEOARD PAEATION

Dashbaard
- Mzin e

Help

Adding your first subscribers

This chapter will explain how to make a list of email recipients,
called subscribers, and how to send your email campaigns.

Blink Mailer is a powerful tool: there are several ways to add subscribers and
demographic information about them (name, location, interests etc).

In this chapter we are going to cover the most basic scenario.

How to get your first subscribers

The chances are, if you are planning to use Blink Mailer, you have some
subscribers already. You may have a complex database of contact information,
a list you exported from an application, or a simple list of emails on a sheet of
paper.

In this example, we will be following the progress of Ethical Pets, who we
introduced in the Case Studies chapter. They will be emailing customers of
their online shop. The list of emails was obtained by exporting a list of
customer emails from their shop software.

Create a list in Blink Mailer

First of all you need to create a subscriber list. This will help you organise your
subscribers. In Blink Mailer, you must have at least one list, but you can have
many of them. In this example, we will create just one list called The Ethical
Pets Gazette, which is the name of the Ethical Pets newsletter.

First, navigate to Subscribers > Subscriber lists in the main menu.

o
r.
Z
N\
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BLINK

Campaigns

Statistics System  Config

Lists that subscribers can sign up to

B LINK

This will take you to a page which shows you all your lists. Currently you can
see just one list, a system default list called test.

To create a new list click the Add a list button.

MAVIGATIC

SUBSCRIBER LISTS
[ UMCATEGORISED v | Categorise lists | | Addalist
) |
1 lists
lists
LISTS MEMBERS FUBLIC ORDER
test e, - 0
g Y& O] &
SAVE CHAMNGES

""" Subscribe
 Export sul
" List mem
et a st

You then need to enter

displayed publicly).

your List name and List description (which may be

In this case, you tick the Public list box too, because we want people to know

about the list.

w5sd
Ll
Ll
L ]

..
88
. 00
S eee

BLINK
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EDIT ALIST

List name:

The Ethical Pets Gazette

-

Public list (listed on the frontend)
Order for listing

0

List Description

For all the latest news and offers from Ethical Pets.

Save | Cancel |

Add Subscribers to Blink Mailer by copy and paste

Once this page is complete, click Save. You can edit this page again later if you
need to. Next we click Add some subscribers

EDIT ALIST

ey

Add some subscribers

This will bring us to the Import Subscribers by Copy and Paste page.

' BLINK
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Blﬁdd&m

We now need to copy our list of subscribers. In this case, the list has been
stored in Libreoffice Calc. Right click the column which contains the emails and
click Copy.

Format Cells...

Lol T 28] Column Width... l
--------------- Optimal Column Width...

Insert Columns Left

Delete Selected Columns -

Delete Column Contents...

Hide

CONONRWNROYEIT VTR WM

Then, returning to Blink Mailer, we right click in the input box and
select Paste.

Cut
IMPORT SUBSCRIBERS BY COPY-ANL Copy ua)
I -
Adding subscribers The Ethical Pets Gazette Delete hel;
Please enfer the email addresses to import, one per line, | Select All Al
"Import Emails” .
~ Check Spelling .-
& Check to skip email addresses that are not valid Languages N 5&
Inspect Element (&) -
=1
Inspect Element with Firebug Imp
Adblock Plus: Block image... 77
Exf
Wi

A BLINK
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;

Finally, we click Import emails.

Adding subscribers The Ethical Pets Gazette

Flease enter the email addresses to import, one per line, in the box B
"Import Emails”

¥ Check to skip email addresses that are not valid

Import emails

e Yy
o e o

m Il-l.!"-l -

o s s = apt]
l.rlll u q-q_!‘ ] ]
[ -_' Ll gl B
g gE e u
m " ey @eE n
u l.l_l

n ot o '] [}

And we are informed of the results of our import,

IMPORT SUBSCRIBERS BY COPY-AND-PA

100/ 616 Imported
200/ 616 Imported
300 /616 Imported
400 /616 Imported
500/ 616 Imported
600 /616 Imported

615 lines processed
615 email imported
0 duplicates

0 invalidated

Send a cam paign Import some more emails

BLINK
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R B I_M
Check it out!

If we return to Subscribers > Subscriber lists in the main menu, we can see
the new list and its subscribers.

[ UncaTEGoRIsED i~ Categorisz lsts | Add a list
2 lists
lists
LISTS MENBERS PUBLIC ORDER
test q_| M 0
8)'8) 0) &)
The Ethical Pets Gazette 614 (2) | @ | C4 0
) ') 0) &)
SAVE CHANGES l

Asking and assuming permission

Before you start to make lists, take some time to consider who you add. A
healthy email list is full of people who want to receive your mail: they should
have given you their email address voluntarily and ideally been asked for
permission before you add them to the system.

There are legal requirements in South Africa which reflect the importance of
informed or assumed permission.

Long term subscriber list health

The ideal situation is for your list members to join and leave your list as they
please. You can set up Subscribe pages so people can subscribe themselves to
your lists, and the (mandatory) Unsubscribe link in your emails will allow
people to leave if they want to. These are discussed in detail in other
chapters.

While you may be keen to spread your message as far and wide as possible,
always bear in mind that excessive, aggressive and intrusive emails can
tarnish your brand. Don't become a spammer!

4
123
il
L.
Z
AN

*e o
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Sending your first campaign

Once you have composed your html message, you are ready to move though
the tabs (highlighted in red below) which will guide you through the process of
sending your first mail.

SEND A CAMPAIGN

subject @

Puuurtect: 50% off Organic Cat Food (BB 20/8/14)

From line (D

The Ethical Pets Humans infoi@ethical .pets.co.uk

Confent @
T5end awebpage @ Ccompose message

Compose message @

‘gé'_ElSnurcc R E:B JF U:i=i= §E|§ = =:[J roma Ncrmd _q@
Dear Cats (and your associated human servanis)
Good news! m
Some silly human types at Ethical Pets have accidentally
Format

If you have a template set up already then the Format gives you the
opportunity to choose it by selecting it from the Use template drop down. Your
html message will then be wrapped in the template during the sending phase.

You can send a test message using the Send test box at the bottom of the
page, to see what your email will look like.

Click next when you have selected your template. If you do not yet have a
template, leave the -- select one in the dropdown and click next.

SEND A CAMPAIGHN

2

Format
format

Send as @

HTML @ text

Use template @

-- select one j

Save as draft ‘ Save and continue editing

L
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Schedule your campaign

After your tests you need to schedule your campaign on tab 3: Scheduling.
Remember, some plugins and settings add extra tabs so the tab number may
change (but the name should stay the same).

In this case we want to send the mail straight away, so the Embargoed
until time needs to be left as the default, which is slightly in the past.

Additionally, because this campaign is not time sensitive, for example there is
no deadline for the special offer, we can leave the Stop sending after time and
date as the default too (far in the future).

When you have finished entering the scheduling information, click next.

3

Scheduling

scheduling

Dates and times are relative to the Semrver Time
Current Semver Time is 2014-08-12 09:28

Embargoed until (2
12j August

Stop sending after @

11 v| |February ~|| 2015 =] |04 ~| 00 ~|

Requeue every @
--do not requele j

Requeue until

12 »| |August  +|| 2014 =] |17 | 00 |

—

Select your lists

One of the final stages in the campaign workflow is to choose the list(s). In
this case there is only one list to choose from, which is The Ethical Pets
Gazette. The options for All Lists and All Active Lists are also useful; the former
sends to every list, public or private, and the latter sends to all public lists.

Remember that Blink Mailer will only send each subscriber one copy of each
campaign, even if they are on several lists: you don't need to worry about
sending people duplicate copies.

ik
0
.
Z
N\
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[S

" Flease select the lists you want to send your campaign to:

o Al Lists
e [ All Active Lists

» ¥The Ethical Pets Gazette (Private list)

Once you have chosen your lists click Next

Sending your campaign

Sending in Blink Mailer is a powerful tool with many possible configurations. It
is possible that your system administrator will give you different instructions
for sending or will send on your behalf.

The final tab in the sequence contains a few useful details and the button
which triggers sending.

First of all you can chose some emails that you wish to alert when your
campaign starts sending and finishes sending. This can help you stay
organised.

You can also choose to Reset click statistics - this means that any clicks or
opens recorded when you were testing your campaign will be forgotten, so
when you get new clicks and opens you know they are from your subscribers.

Finish

SEND A CAMPAIGN

finish

email to alert when sending of thi§ message staris
separate multiple with a comma

info@ethical-pets.co.uk

email address to alert when sendiflg of this campaign has finished
separate muliiple with a comma

info@ethical-pets. co.uk

@ add Google Analytics tracking code

(®) Reset click statistics
]

— ge: 11KD
Estimated size of text message: 2Kb
Estimated size of mailout: 5.91Mb
About 621 subscribers to receive HTML version and 0 subscribers to receive text version

send campaign

BLINK
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When you are ready to send, click send campaign.

Process your queue

Clicking send will add your campaign to your queue. There may be only one
campaign in the queue, or there may be several. Click process queue to send
the campaign now.

SEND A CAMPAIGN

Campaign added

Campaign queued

—

You will see the queue start to process, with a spinning logo.

SEND THE QUEUE

Processing queued campaigns

‘*, stop processing

Next you will see something like the image below, depending on how your
system is configured.

— p— ———— —

| |

SEND THE QUEUE

Processing queued campaigns

% stop processing

Starteq 200/ 621

Processing has started, 1 message(s) to process.

Flease leave this window open. You have batch processing enabled, so it will reload
several times to send the messages. Reports will be sent by email to listreports@uk-
webspace.com

FProcessing message 1
Looking for subscribers

Found them: 621 to process

Script stage: 5

200 messages sent in 29.52 seconds (24390 msgs/hr)
Finished this run

Waiting for 3600 seconds before reloading

5. B LiNK
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All done?

Blink Mailer is configured to run in the background so there is no need for you
to leave the page open or your computer on. Alerts will be sent out every time
450 emails are sent (every 2 hours) and when the campaignhas been
completed.

-
*8

@
*e

Basic campaign statistics

Now that you have sent your first campaign, it's time to take a look at your
campaign statistics. In this chapter we will look at Sent, Rate Bounces,
Forwards and Views, the four most fundamental campaign statistics.

The statistics overview page

First, go to Statistics > Statistics overview.
ISL

aigns  Statistics | System Config  Info

M Summary of statistics of the last few campaigns sent out
3 DESTTIOETT

help

Domai

About phpList

This will show you a summary of all the campaigns you sent in the past year
(in this case, we have just sent one).

Download as CSV file

SENT ENCS FWDE VIEWS

Puuurfect: 50% off O ... 20/8/14) 621 ] ] 156

DATE: 15 AUG 2014 | RATE: 23.12 %

Sent

In this example, we sent our first campaign to 621 subscribers and this is
reflected in the SENT column. It is useful to see how many subscribers you
have for each campaign, so you can see your list grow over the year.

A BLINK
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Bounces

The second column BNCS shows the number of emails that "bounced." A
bounced email is one that cannot reach its intended recipient. This could be
caused by any number of things, for example:

« The email is incorrect, does not exist or has an error such an expired
domain

* The Mailbox is full (this may be temporarily or not)

* A badly configured auto-responder (automated "I'm on Holiday till" or "I
got your message and will reply soon" type mails)

The exact definition of a bounce depends on your Blink Mailer configuration,
and it can take several days for a bounce to be registered on the system. An
email which continues to bounce will eventually be either unconfirmed or
added to a do-not-send list.

A high bounce rate may be a sign of poor list quality.
In this campaign there were 0 bounces.

Forwards

The third column FWDS shows the number of people who have forwarded the
mail through the Blink Mailer ForwardToFriend system. This is dealt with in
Advanced Statistics.

"Views"
This is the most exciting of your statistics, but also the most misleading.

In this case, our email was "viewed" by 156 of the 621 recipients, which gives
us an open RATE of 25.12%. However, it is important to understand the
limitations of this statistic, so you don't become frustrated or disillusioned by
what may seem like low readership levels.

The VIEWS statistic:

 Tells us how many people were recorded opening their email (and
presumably read the contents)

* Tells us the minimum number of people who opened the email

* And gives us a rate that reflects the number of people opening an email
compared to other emails we send.

* Does not tell us exactly how many people opened the mail, or what they
did when they opened it.

An "open" is not always recorded.

The major cause of inaccuracy when recording views is image blocking. If
images/remote content are blocked by a subscriber's email software, then the
action of your subscriber opening the email cannot be reported back to Blink
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Mailer (or to any system). Image blocking is therefore quite commonly used as
a privacy feature by email and webmail clients.

To protect your privacy, Thunderbird has blocked
remote content in this message, | Show Remote Content |

Always load remote content from info@ethical-pets.co.uk

Dear Cats (and your associated human

CB '
servants) = image of a bag of

Yarrah cat food
Good news!
Sorme silly human types at Ethical Pets have

accidentally over-stoclked Yarrah Crganic
and MSC certified dry cat food (the one

Only when your subscriber clicks, for example Show Remote Content, is the
view recorded in your campaign statistics.

et
Show Remote Content

ts.co.uk .
iy Ur associated Ruman

= image of a bag of
Yarrah cat food

Some silly human tyes at Pats have YR FWDS 1
accidentally owver-stocked Yarrah = i)

DATE; 2T AU G 3014 [FA

Still a useful statistic...

This inaccuracy is the same for everyone, no matter which software they are
using to send their campaign; any "open rate" averages you see discussed on-
line or in books are subject to the same rules.

It is difficult to estimate how much higher your real readership is, additionally
the inaccuracy rate will vary from campaign to campaign. If we bear this in
mind, we can still make some comparisons, for example "have I received more
views over several campaigns" and "how I compare to the industry average."

What's the difference?

The difference between the real open rate and the statistic may be very
significant: in this case, a quick study found that only 1 in 3 of the customers
who bought the cat food in the hours after the email was sent showed up in
the open results, and the cat food offer was only advertised by email. In this
case, the real open rate could be more like 80%.
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Rate ”

To compare performance across several campaigns you can use the RATE
statistic, which is the number of opens expressed as a percentage of the total
sent. In this first campaign, we had an open rate of 25%.

Over time, as our list keeps growing, we can still compare back to see if we are
keeping our subscribers interested. The rate statistic can also be used to:

» a/b test email titles and sending times
* to compare readership between lists
* and even to benchmark performance against industry averages.

Summary

This Statistics Overview page is useful for comparing and contrasting the
success campaigns. This can help you to improve your future campaigns.
However, the statistics should not be taken too literally.
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Growing & using

complex lists

Understanding subscribers &
lists

It is important to understand the nature of Subscribers and Lists in Blink
Mailer.

What is a subscriber?

A subscriber is usually someone who is a member of one or more of your lists.
They may have subscribed themselves though a subscribe page, or you may
have imported their details from another source.

It is important to understand, however, that a subscriber may not be on any
list. This happens when you:

*Import subscribers but do not assign them list membership
*Delete all the lists a subscriber was a member of (without deleting the
subscriber)

What is a subscriber profile
All the data about a subscriber is stored in their subscriber profile.

This profile can be found by searching for their email in Subscribers > Search
Subscribers. To see all subscribers search for @.

Here are some examples of the kind of data held in a subscriber profile:

On the Details page you can see information like ID, email address, confirmed
or not, blacklisted or not, number of bounces and html or text emails. Some of
this information is editable.

S BLINK

a
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History remaove subscriber
lDetaiIs| Lists ‘
11} il
Email
Is this subscriber confirmed [1L0) 1
Is this subscriber blacklisted Mo i i
Didl this subscriber manually confirm 0
Humber of bounces 0
Entered 2014-11-17 14:52:59
Last Modified 2014-11-17 16:44 .47
Unigue ID be070calddcad26d028edE50f69d09be

Send this subscriber HTML emails 1

By clicking on the Lists tab you can see the lists which the subscriber is a
member of, and you can edit this too.

History remove subscriber

‘ Details ‘ Lists |

Mailinglist membership:

I# newsletter

I test

¥l Dog category purchasers
I#/ The Ethical Fets Gazzette

Sawve changes

By clicking on the History button you can see all the campaigns that have been
sent to the subscriber.

BLINK
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Dl i = rémove subscriber
1 messages saent to this subscriber
|| Campaigns l Subscription J
MBSSHQES
MESSAGES CLCKES SENT WVIEWED RESFONSETIME
Bd 3 22 May 2014 08:30:47 22 May 2014 14205:06 20059
75 0 9 Dec 2013 20:02:46 L0 Dec 2013 13:16:23 62017
71 3 € Nov 2013 17:32:13 T Nov 2013 16.05:12 B1179
70 0 17 Oct 2013 20:25:52
B9 0 11 Oct 2013 17:24:02 11 Oct 2013 20:16:28 10346
£o & A MSad 3B 15 101890 S Sas SRS 140 8859 o Ta T o |

By clicking on the numbers in the CLICKS column you can see detailed
information about which images and text links they clicked on, when and how
often.

Subscriber click details for a message

Subscriber 2

subject Special Offar on Sea Algae dog chews
Entered 2014-11-17 16:56:56

Sent 2014-11-17 22:46:27

Subscriber click statistics

SUBSCRIBER CLICKSTATETES MESSAGE FIRETCLCK LATESTCLEK CLEKS
ethical-pets.co.ukdl ... ward&mid=2 2 20 Mov 2014 13:06:53 20 Mow 2014 13:06 1

TEXT-0 | HTHL: 1

s ethirslnate fo Lhewre bl 2 20 nloy 2014 13-45-30 20 e 2014 13-4 il

As you can see, the subscriber profile is the central place where all information
about a subscriber is stored. This is very different to list membership.

What is a list?

A list is a way of grouping together subscribers so you can send them
campaigns. However the list itself does not contain the subscriber details. As
you have seen, all that information is in the subscriber profile.

You can view your lists by going to Subscribers > Subscriber lists from the
main menu. Next to each list is the number of MEMBERS that list has.

A BLINK
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SUBSCRIBER LISTS
UINEATEGORISED iv Categorise lists Add a list
3 Lists
Lists
LETS MEMBERS FUBLE ORDER
test 1|& ] O 0
o)) 0] &5
newslatter 1 E v 0
2)'s)0) &)
The Ethical Pets Gazzetie 754 |0, | 4 0
2] %) 0] 5]
SAVE CHANGES

However, if I delete the list, I have not deleted the subscribers.
Some examples of how this works in practice

A useful tool to help understand lists and subscribers is the All
subscribers feature, which was added in version 3.0.8. When this feature is
enabled (in the config.php file) you can see the total number of subscribers
shown alongside your lists.

Let's do some experiments with adding and deleting lists to see what happens
to the All Subscribers total.

At the start of our test, the number stands at 5327. That means we have 5327
subscriber profiles in our system all together.

1 Lists

Lists

LISTS MEMEERS

All subscribers 5327 (1) G|

test

SAVE CHANGES
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If we create a new list, and paste in the emails of some of our subscribers, we

can add these subscribers to the list and send Campaigns to just a sub-section
of our total humber of subscribers.

Adding subscribers Just a list

Flease enter the email addresses to |

¥ Check to skip email addresses th

Import emails

The outcome is a new list (in this example with 662 members). However, you
can see that the All subscribers total stays at 5327. This is because we have

not added any new subscribers, we have just created a list out of current
subscribers.

2 Lists
Lists
LISTS MEMEERS
All subscribers 5327 (1) Q|
test -y
Just a list 662 @

Now, if we delete the new list with its 662 members,

Just a list 662 @ |

delete this Lis

BLINK

AFFORDABLE MARKETING SPECIALISTS
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S BLINKS

the All subscribers count does not go down either, it is still 5327.

deleting list 6 .. ..done

F 4 N ™

| UNCATEGORISED Pw

b A

1 Lists

Lists
LISTS MEMEERS

All subscribers 5327 (1) | &, |

test - N

We can repeat this test, but this time add a mixture of current subscribers (2)
and new subscribers whose data we have never introduced to Blink Mailer
before (8). You can see Blink Mailer processes all the lines, imports 8 new
emails to the system and marks 2 as duplicates.

-

Subscribers  Campaigns  Statistics  System Config  Info

IMPORT SUBSCRIBERS BY COPY-AND-PASTE

10lines processed
8 email imported

2 duplicates

0 invalidated

All of these emails are added to our new list, and additionally, our All
subscribers count goes up by 8 subscribers to5335.
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2 Lists

Lists

LISTS MEMEERS

All subscribers 5335 (1) | @, |

test

A list with totally new subscribers on it

SAVE CHANGES

Adda“51|

We have added 8 new subscribers to the system, and Blink Mailer has created
8 new subscriber profiles for us. If we delete our new list again...

——J =7

A list with totally new subscribers on it ay @l ¥

Y
delete tl
CHANGES

The List is deleted, however the subscriber count stays at 5335. We have only
deleted a list, we have not deleted any subscribers.

deleting list 7 .. ..done

i .
| UncaTtecorisED iw cal
b

1 Lists

Lists

LISTS MEMEERS P

All subscribers 5335 (1) | €@ |

test e
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How to delete subscribers

You should not delete subscribers in most circumstances. If a subscriber wants
to stop receiving emails from you they can unsubscribe. Unsubscription means
that:

* Their email will be kept on the system and added to a do-not-send list
(blacklist)

* Your Blink Mailer system will never send a campaign to them again,
unless they re-subscribe

« If you import their email again (by accident) you will not be able to send
them campaigns inadvertently

* You have a record of when/why they unsubscribed which you can use to
improve your campaigns in the future

If you are in a situation where you want to delete some subscribers rather than
simply blacklist them, for example, to bring the size of your lists down, first try
the options on the Reconcile page, for example to remove those with x number
of bounces, those with an invalid email and those who are not-confirmed.

The final resort is to get some emails by exporting them (from Export
subscribers) and then pasting whichever emails you wish to delete into the
bulk delete function. This can be found though the Manage Subscriber page.

Creating your lists

In Blink Mailer you can organise your subscribers into lists. You must have at
least one list. You may find that having multiple lists, that is, Segmenting your
list, improves subscriber satisfaction and opens/clicks.

There are several factors to be aware of:

*  You must select at least one list when sending

* You can select several lists or use the all lists function when sending

* Subscribers will never get the same campaign twice, even if they are on
several of the lists you select

» Lists can be categorised to help you keep organised

+ Lists are not the same as Attributes

Now that you know the basics, it's time to get started.

AFFOREABLE MARKETING 3RECIAL ara pg 40



Growing and using complex lists §

Go to your lists page

Go to Subscribers > Subscriber lists from the main menu.

. BLINK

Subscribers  Campaigns  Stafistics  System  Con

Search subscribers

AR | ists that subscribers can sign up to

r continue a campaign

This will take you to your SUBSCRIBER LISTS page, where all of your lists will
be displayed.

There are two lists by default, test and newsletter.

You can view lists by category, or view lists which have no category by
selecting Uncategorised from the dropdown menu.

SUBSCRIBER LISTS
| UNCATEGORISED ‘v | Categoriselists | Addalist
2 lists
lists
LISTS MEMEERS FUELIC ORDER
test - O 0
) ‘& O |
newsletter 1ey | [ 0
f ) % 0 O |
SAVE CHANGES |
Add a list ‘

A BLINK
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Add a list
Click the Add a list button at the top of the page.

MNaviGaTIoN

Dashboard

Change the details for a list

Categorise lists

Log out

Fill out the details using the guide below to help you.

phpList :: phpList :: Edit a list = Mozilla Firefox x

File Edit View History Bookmarks Tools Help

o

f."'/ & phplList :: phpList : E... % | =k

p

.,\(' | @ www.gingerling.co.uk/lists/admin/?page=editlist& = v C"| » | =

EDIT A LIST

List name:

Garden how-too's and updates

C4
Public list (listed on the frontend)
Order for listing

0

Category
gardening j

List Description

List Name

This will help you to keep your lists organised and remember what the list is
for. If your list is public this name will be displayed on your subscribe pages. If
your list is private, the name will be known only to you (and possibly to other
people who manage your Blink Mailer installation).

A BLINK
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Public List
The Public List box should be checked when

* You want subscribers to be able to add themselves to the list using a
subscribe page

* You want subscribers to be able to leave this individual list (but stay on
others)

* You have chosen a list name and description which you are happy to
display publicly

If you do not make the list public, it is considered private, and it will not be
seen by your subscribers.

Category

Categories can be used to help organise your lists. If you decide to use them
there is lots of information in the categories chapter, however, here is a
summary:

« If you have no categories then the category dropdown will not display on
this page

* You must use categories if you have more than 16 lists

« If you have some categories already but you want to leave this list
uncategorised then simply leave -- Choose category in the dropdown

In this instance we had already set up some categories and chose the
category Gardening from the dropdown.

List Description

This information will display on your subscribe pages if the list is public.

Save and repeat

When you have filled out the page click Save. You can come back and edit the
info again later if you need to. You can create as many lists as you need.

You will be prompted to add some subscribers to the list. See the next
chapters for more guidance.
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Adding subscribers to lists

There are three main ways to add subscribers to your Blink Mailer installation:

copy and paste a list of emails
upload a file with emails
upload a CSV file with emails and additional data.

Subscribers  Campaigns  Statistics  System  Config  Info

IMPORT EMAILS

Please choose one of the import methods below

E“ copy and paste list of emails

o

import by uploading a file with
emails

import by uploading a CSWV file
with emails and additional data

This chapter deals with each of these methods in three stages

When and why you might use the import method
Preparing your data
Importing your data

Why is (to lists) in brackets?

It is

You

important to remember that:

Subscribers can exist on the system without being a member of any list
In this chapter it is assumed that you will be adding subscribers in the
form of a list, but you can add them without making/choosing a list if
you want to
When you add a subscriber to the system for the first time, a subscriber
profile is created
Adding the subscriber to more lists does not create more profiles, all the
subscriber details are saved in one profile no matter how many lists the
subscriber is on
Deleting the list does not delete the subscribers.

can read the chapter about the difference between subscribers and lists for

more information.

e

# BLINK
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Copy and pasting
Why and when to use this method
If your data is very simple, just a long list of emails in a paper or digital

document, then this could be the method for you - especially if you are not
very confident with file formats.

If the emails are on paper then you could type them directly into the import
dialogue, however, it is probably better to type them into a document first.

This is also the method you will use when you create a new list from
subscribers that are already on your system.

Preparing your data for this method

Preparation for copy and pasting the emails in is minimal. You may need to do
nothing at all.

If your emails are in a text file or a word-processing file, you need to open the
file with the emails in, and make sure the data is just a list of emails, one on
each line and with no punctuation.

If your emails are in a spreadsheet or csv file you do not need to prepare
them. However, if this is the first time you will be adding the subscribers to the
system you may wish to use a csv import to allow you to add more of your
data to their subscriber profiles.

Importing your data
If your data set consists of a list of emails in a file, like this:

emails, txt (~ Tl Gl oe i el dialen gl x

File Edit View Search Tools Documents
[jf I:L()pen ~ Eﬁ Save | EE? | <=)Undo | v

, D emails.txt > \

KayleighHopkins@jourrapide.com
FinleyMay@einrot.com|
KatieHughes@gustr.com
AbbieDaniels@rhyta.com
EloiseSimmons@einrot .com
SophiePreston@jourrapide.com
JadeBrennan@einrot.com
NaomiThornton@einrot .com

Al fieKnight@armyspy.com
MeganRead@einrot .com
GabrielDaniels@superrito.com
FinlayBolton@superrito.com
GeorginaRichardson@gustr.com
JosephForster@einrot .com
LucyColeman@cuvox.de
TillyFaulkner@cuvox .de
WilliamMoss@superrito.com
CourtneyBradley@rhyta.com
PeterJoyce@gustr.com

Plain Text v  Tab Width: 8 v Ln 2, Col 21 INS

A BLINK
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Or a complex data set in a spreadsheet like this, from which you only wish to
upload the emails

14 v #z 2 = | Bolton
Al B € S — E
1 ID |Title |GivenName |Surname EmailAddress
2 1Ms. |Kayleigh  |Hopkins Kayleightopkins @jourrapide.com
3 2Ms. |Mia Gilbert MiaGilbert@jourrapide.com
4 3Mr.__|Finley May FinleyMay@einrot.com
5 4/Mrs. |Katie Hughes KatieHughes @gustr.com
6 | 5Ms. |Abbie Daniels AbbieDaniels@rhyta.com
7 6|Mrs. |Eloise Simmons EloiseSimmons@einrot.com
8 7|Ms. |Sophie Preston SophiePreston@jourrapide.com
g 8|Mrs. |[Jade Brennan JadeBrennan@einrot.com
0 Qs INaomi Thormion NaomiThornton@einrot com

Then first you need to select them in your document and copy them. This is
often done by pressing:

Control+C or
Right click > Copy or
Edit > Copy.

Then go to Subscribers > Import emails from the main menu
HTHE D LI

s WA LA

Subscribers | Campaigns  Stafistics

o i |[mport emails
View bounces per list

Suppression list

Reconcile subscribers
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Click the copy and paste list of emails button in Blink Mailer

IMPORT EMAILS

Please choose one of the import methods below

E“ copy and paste list of emails lh,l

Import subscribers by cut-and-paste

o
El- import by uploading a file with
2mails

You will then see the following page:

IMPORT SUBSCRIBERS BY CUT-AND-F

Select the lists to add the emails to

s VAl Lists

s Al Active Lists

e newsletter (Public list)
Sign up to our newsletter

o [test (Private list)
List for testing.

Flease enter the emails to import, one per line, in the box b

& Check to skip emails that are not valid

Import emails

First choose a list by ticking the box next to the list name.

You may also Add a list, or tick All Lists. Also, it is best to leave the Check to
skip emails that are not valid box ticked. Next, paste your emails into the box,
using

« control+v
* Or right click and Paste.
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e Add alist

» Pnewsletter (Public list)
Sign up to our newsletter

o test (Private list)
List for testing.

FPlease enter the emails to import, one per line, in the box below and ©

¥ Check to skip emails that are not valid

Im port emails

KayleighHopkins@ jourrapide.com
MiaGilbert@]jourrapide.com
FinleyMay@einrot.com
KatieHughes@gustr.com
AbbieDaniels@rhyta.com
EloiseSimmons@einrot.com
SophiePreston@]jourrapide.com
JadeBrennan@einrot.com

Click the Import emails button.

You will then see the results of your import.

SUDSCTIREN S AlTIPEIgns Sldlslss SYSLEN

IMPORT SUBSCRIBERS BY CUT-ANI

17 lines processed
17 email imported
0 duplicates

0 invalidated

Send a campaign

Im port some more emails |

Upload a file with emails
Why and when to use this method

If you have a digital list of emails with no other data, and you know how to
save them as a text file, then this is the right method for you.

If you have more than just emails in the file and you want to upload all of the
information, you will need to use the CSV import.

. BLINK
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Preparing your data
Your file needs to be formatted:

* One email per line

* No spaces, tabs, commas etc.

* You need to save it as plain text (filename.txt)

* You should only edit it in a text editor such as NotePad, TextEdit or
Geany.

emails.txt ("IH [ A e - & # x

File Edit View Search Tools Documents
D'EGWHVSM‘@‘G@Unm@| w

.F D emails.txt * 1|I

KayleighHopkins@jourrapide.com
FinleyMay@einrot.com|
KatieHughes@gustr.com
AbbieDaniels@rhyta.com
EloiseSimmons@einrot.com
SophiePreston@jourrapide.com
JadeBrennan@einrot.com
NaomiThornton@einrot.com

Al fieKnight@armyspy .com
|MeganRead@einrot .com
GabrielDaniels@superrito.caom
FinlayBolton@superrito.com
GeorginaRichardson@gustr.com
JosephForster@einrot.com
LucyColeman@cuvox .de
TillyFaulkner@cuvox . de
JWilliamMoss@superrito.com
CourtneyBradley@rhyta.com
FPeterldoyce@gustr.com

Plain Text v Tab Width: 8 v Ln 2, Col 21 INS

It is still possible to import this data when there is additional information after
the email, for example:

FinelyMay@einrot.com age 23 from Southport likes chips with curry sauce

But, everything after the end of the email will be discarded. Additionally, if you
have any punctuation attached to the end of the email, for example,

FinelyMay@einrot.com, age 23 from Southport likes chips with curry sauce

then the data will be corrupted because the comma at the end of the email
address will be imported as part of the email.
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Importing your data

Go to Subscribers > Import emails from the main menu
B L1 NYK

Subscribers | Campaigns  Statistics

Export subscribers o
i g |[mport emails
View bounces per list

jon list

ncile subsc

Click Import by uploading a file with emails.

IMPORT EMAILS

Please choose one of the import method

g copy and paste list of emails

Xy |mpcfrt by uplnamga file with
emails

s
& import by uploading a CSV file
with emails and additional data

m
L,
Z
A
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You will then see the Import Subscribers From Text File page.

IMPORT SUBSCRIBERS FROM TEXT FILE

Select the lists to add the emails to

o Al Lists

o 1Al Active Lists

o [ newsletter (Public list)
Sign up to our newsletter

o [test (Private list)
List for testing.

The file you upload will need to contain the emails you want to add to these lists. A
be added as attribute "Info” of the Subscriber. You can specify the rest of the attriby
below. Warning: the file needs to be plain text. Do not upload hinary files like a Worl

File containing emails: | e | No file selected

If you check "Test Output”, wou will get the list of parsed emails on screen, and the
with the information. This is useful to find out whether the format of wour file is corre
50 records.

Test output: [}

| prefer to receive emails in HTWL format

M

First choose a list by ticking the box next to the list name. You may also Add a
list, or tick All Lists. Then select a file to upload by clicking the Browse...
button. Navigate to the file on your computer and click Open. Then click the
Import button.

o [Pnewsletter (Public list)
Sign up to our newsletter
o [test (Private list)
List for testing.

The file you upload will need to contain the emails you want to add to these
be added as attribute "Info" of the Subscriber. You can specify the rest of th
below. Warning: the file needs to be plain text. Do not upload binary files liki

File containing emails: | Browse... | emails.txt

If you check "Test Output”, you will get the list of parsed emails on screen,
with the information. This is useful to find out whether the format of your file
50 records.

Test output: ]

| prefer to receive emails in HTML format

S

You will see the emails importing.

- BLINK
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Upload a CSV file: emails and some additional information
Why and when to use this method

This is the method used when you have a spreadsheet full of data, where there
might be names, emails, addresses... Often this data will have been exported
from another source, such as a CMS, CRM, webshop, database or email
address book.

If you have such data, it is a good idea to upload a CSV file the first time you
add subscribers to the system and you are asked to make a list (even though
you will only be prompted to copy and paste). From then on, unless you need
to re-synchronise or add some new data, you can just use copy and paste to
add subscribers to lists.

Preparing your data

When you have emails and some additional information, such as Name and
Gender, you need to

* Open the data in a spreadsheet
« Rename some columns to avoid or utilise Blink Mailer system values
« Save as a csv - make a note of the delimiter.

Example Dataset for CSV Import

In this example we have ID, title, first name, email address, height in cm and
gender, and they are stored in a spreadsheet format (xls, ods or similar).

i TV 9@ 2 — | Bolton

L ID |[Title |GivenName |Surname EmailAddress

2 | 1Ms. |Kayleigh  |Hopkins KayleighHopkins@jourrapide.com
g 2|Ms. |Mia Gilbert MiaGilbert@jourrapide.com

b 3Mr._|Finley May FinleyMay@einrat.com

5 4|Mrs. |Katie Hughes KatieHughes@gustr.com

6 5Ms. |Abbie Daniels AbbieDaniels@rhyta.com

7 6|Mrs. |Eloise Simmons EloiseSimmons@einrot.com

4] 7|Ms. |Sophie Preston SophiePreston@jourrapide.com
g 8|Mrs. |Jade Brennan JadeBrennan@einrot.com

0 QlMs  Naomi Thornton NaomiThormton@einrot com

Data that includes an ID

When you use another application, a blog, webstore, CRM software etc, you
may want to keep the data in Blink Mailer synchronised with the data in your
other app.

Blink Mailer allows you to do this accurately by using a foreign key: this means
that the ID tag or number used to identify an individual in your other
application can also be used to identify the subscriber in Blink Mailer. This
means that:

' BLINK
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« If a subscriber's email address changes in your other app, this can
be updated in Blink Mailer

« Any changes to subscriber attributes can be updated automatically,
for example surname, location, date of last purchase from your
store.

If you wish to use the ID as a foreign key you should rename the column ID
(or similar) to foreign key.

Renaming columns to avoid Blink Mailer system values

Some words are already used by Blink Mailer to describe data: these are called
Blink Mailer system values. Blink Mailer will not allow you to import data from
columns in your CSV when certain system values are used as a column title.
These columns will simply be skipped when you try to import.

It is common for other software and web applications to use the same system
values. Columns must be renamed before the data exported from one app can
be imported into Blink Mailer. Here are some examples (a full list can be found
later in the chapter):

- ID
« confirmed
« passwordchanged

Renaming columns to match Blink Mailer system values

Some columns can be renamed to match Blink Mailer system values, because
those system values are designed to take imported data.

In the example below we rename the column Email address to Email. It is
possible to achieve the same thing during import by mapping one term to
another.

A B E]E =S E ] 8 7 w03 ST

Email He

KavleighHopkins@jourrapide.com
MiaGilbert@jourrapide.com
FinleyMay@einrot.com

KatieHughes@aqustr.com

Abbioaanisleotrbata s

As another example, the ID column can be renamed to Foreign Key. This
allows the data to be put to use in Blink Mailer when otherwise it would just be
skipped. In this case, Blink Mailer would not allow you to map ID to Foreign
key during import so this task must be done before upload.

ik
0
.
Z
N\

* o
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unique_1 (2, 3 etc) or
index_1 (2, 3 etc)
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Will be skipped

VI 2 =— | |Forster
A B c e E
Foreign Key |Title |GivenName |Surname Email

1|Ms. |Kayleigh Hopkins KayleighHopkins@jour
2|Ms. |Mia Gilbert MiaGilbert@jourrapide
3|Mr.  |Finley May FinleyMay@einrot.comn
4|Mrs. |Katie Hughes KatieHughes@gustr.co
5|Ms. |Abbie Daniels AbbieDaniels@rhyta.cq
6|Mrs. |Eloise Simmons EloiseSimmons@einrg
7|Ms. |Sophie Preston SophiePreston@jourral
OB - Lol [T e Ty = Y PN p P LT e e W T o Tt A

id Will be skipped

email Will import

confirmed Will be skipped

blacklisted Will be skipped

optedin Will import

bouncecount Will be skipped

entered Will be skipped

modified Will be skipped

uniqid Will be skipped

htmlemail Will import

subscribepage Will be skipped

rssfrequency Will be skipped

password Will import

passwordchanged Will be skipped

disabled Will import

extradata Will import (as attribute)

foreignkey Will import
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Saving the file

Next we need to save the file as a CSV file, a comma separated value file. You
should ideally change the delimiter to tab. If it is not tab, you will at least need
to be aware of what the delimiter is so you can tell Blink Mailer when you
import.

Importing the subscribers

First go to Subscribers > Import emails from the main menu.
B L1 INYK.

Subscribers | Campaigns  Statistics

oer lst Import emails
4l =18

Click the final option for import by uploading a CSV file with emails and
additional data.

lease choose one of the import methods below

g“ copy and paste list of emails

':.3:; import by uploading a file with
emails

e
& import by uploading a CSWV file
with emails and additin!ll data

Import subscribers from CSV file

You will then see the Import Subscribers From CSV Page.

A BLINK

AFFOREASLE MARKETING SRECIALISTS pg 55



and using complex lists .88 ‘ Ny

IMPORT SUBSCRIBERS FROM CSV H

Select the lists to add the emails tq

o 1Al Lists

o 1Al Active Lists

e Add alist

newsletter (Public list)
Sign up to our newsletter

[Mtest (Private list)
List for testing.

First choose a list by ticking the box next to it. You may also choose All Lists or
Add a list.

¥ Audd o et

o | @newsletter (Public list)
Sign up to our newsletter

Next upload your CSV file by clicking Browse..., choosing the file on your pc
and clicking Save.

foreign key is 100. Warning: the file needs to be plain text. Do not

i ini ils: [ | .
File containing emails: Eaet N o1 5ils . csv

The following limits are set by yvour
Maximum size of a total data sent f]
Maximum size of each individual filg
than 5ME

Field Delimiter:

(default is TAB)

fyou check "Test Output”, wou will get the list of parsed emails on

TR T N N Y m e o PRI N | el Ll PR P

You must also indicate the delimiter, this is what separates each item in your
CSV (in place of the column lines). If you are unsure what the delimiter of your
file is, you can open the file into a plain text editor such as Notepad. You will
see what is separating the items. In this case it is a comma, so we put a, in
the Field Delimiter box.

A BLINK
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Foreign Key,Title,GivenName,Surname,Emal
1,Ms. ,kKayleigh,Hopkins,KayleighHopkins@]
Z2,Ms.,Mia,Gilbert ,MiaGilbert@jourrapide
3,Mr.,Finley,May,FinleyMay@einrot.com, 1]
4,Mrs. ,Katie,Hughes,KatieHughes@gustr.cq
5,Ms.,Abbie,Daniels,AbbieDaniels@rhyta.
6,Mrs. ,Eloise,Simmons,EloiseSimmonsi@ein
7,Ms.,Sophie,Preston,SophiePreston@jour
8,Mrs.,Jade,Brennan, JadeBrennanieinrot.
9,Ms. ,Naomi, Thornton,NaomiThornton@einrg
16,Mr.  Alfie,Knight, Al fieKnight@armyspy

There are various other options on this page, which all have a description.
Generally, it is good to keep the Test Output option checked.

Use the Overwrite existing and/or Retain old email options to preserve the data
set which should be held safe; it is the source of most up-to-date data.

When you have finished filling out this form, click Import.

Eiiéi;l

You will now see a page where you can match the data in your file to attributes
on the system. Attributes such as Foreign Key and Email will not appear on this
page because the system deals with them automatically: all the attribute on
this page are new to the system.

IMPORT SUBSCRIBERS FROM CSV FILE

Reading emails from file ... ok, 13 lines

Please identify the target of the following unknown columns

Import Attributes

IMPORT ATTRIBLITES SELECT
Title -- Create new one j
Givenkame -- Create new one j
=3
Surname -- Create new one j
Centimetres -- Create new one j
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Click on each dropdown - is the correct attribute already in the list? If not,
select Create new one. This will create a new attribute in your Blink Mailer so
that next time you import similar data the system can deal with it
automatically.

't Attributes

IMPORT ATTRIBUTES SELECT
Title |- Create new one -~
-- Create new one )
_ -- Skip Column &l
Givenhame Send this subscriber HTML
RSS Frequency
Password

-
=umame |5 this account disabled?

Problem? If you see something like the image below, where all your attributes
are on one line, then you have used the wrong delimiter.

Imns

Import Attributes

IMFORT ATTRIBUTES SELECT

Foraign Key,Title GivenMame Surname, Emall,Centimetres, Gender Create new one j

CONTINUE

You will also see some test data, that will give you a strong indication of
whether your import is going well. Each column title from your csv should line
up with some data about one of your new subscribers.

12 lines will be imported

Confirm Import

Test Output

email -= KayleighHopkins@jourrapide.com
foreignkey -= 1

htmlemail -= 1

Title -= Ms.

Giventame -= Kayleigh

Surname -> Hopkins

Centimetres -> 158

Gender -= female
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Problems?

If you see anything wrong in the test, do not proceed! Click the Reset import
session button to start again, check your delimiter settings and/or get help. A
messy import is no fun to fix!

When all attributes have been dealt with and you are happy with your test
data, click Continue.

Gender

o

You will be shown a summary of what will happen when you import. Now you
can see that Foreign Key and Email are matched automatically, and all your
other attributes will be created for you.

Tivnn L g oy g oy mmy g e pa Y L] cp e B AN B |y my

Reading emails from file ... .. ok, 13 lines .
Summary
SUMMARY MAFS TO
Foreign Key system: foreignkey
Email system: email
Title Create new Aftribut
GiventMame Create new Aftribut
Surname Create new Attribut
Centimetres Create new Attribut
Gender Create new Attribut

12 lines will be imported

Confirm Import

If you are satisfied, click Confirm Import.

S BLINK
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IMPORT SUBSCRIBERS FROM CSV FILE

Reading emails from file ... . ok, 13 lines

Importing 12 subscribers to 1 lists, please wait

12 emails succesfully imported to the database and added to 1 lists,
12 emails subscribed to the lists

12 duplicate emails found.

Subscriber data was updated for 12 subscribers

12 subscribers were matched by foreign key, 0 by email

Im port some more emails

You will see that your subscribers and their data has been imported.

A BLINK
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Creating a subscribers page

A subscribe page usually consists of a short form that a visitor to your website
can fill out to subscribe themselves to one or more of your lists. Here is an
example:

Subscribe to updates from Ethical Pets: news, reviews and special offers

PREQUIRED FIELDS ARE LARKED RED

Confirm your emal address

# | prefer to receive emails in Text formar

Last name

In the example above, the subscriber is asked to input their email address and
to confirm it. They can then choose to receive a text version format and they
can add their first and last names if they wish.

In Blink Mailer you can have an unlimited number of pages, combining any set
of Attributes, Lists and Languages.

Additionally you can use pages in conjunction with scripts to create subscribe
forms which integrate more closely with your website. As this is a custom-
made process for individual sites we do not have generic documentation about
it.

Create a page

To get started with subscribe page visit Config > Subscribe Pages.

Statistics  System  Confi

Continue the Configural
or attributes

Ftart or continue a cam

A BLINK
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Initially you'll find this page empty, with no subscribe pages to display,
although there is a default subscribe page at www.yourdomain.com/lists.

The first page you make will replace this default page and later you can set
any page as default.

To create a new page click Add a new subscribe page.

Subscribers  Campaigns Statistics System  C

SUBSCRIBE PAGES

Edit a subscribe page

This will open a page called EDIT A SUBSCRIBE PAGE.

Customise a Subscribe Page

The subscribe page editor is broken into four collapsible areas:

* General information
 Transaction messages

» Select the attributes to use
« Select the lists to offer

EDIT ASUBSCRIBE PAGE

r General Information
b Transaction messages
r Select the attributes to use

F Select the lists to offer

Save Changes

These sections will guide you though creating a subscribe page which meets
your specific needs.

General information

The first box edits the titles and text on the page. Enter your title in
the Title box first of all.

. BLINK
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You can leave Language file to use as --default, unless you are creating a page
for a language other than the one you use for your installation, for example, if
you are creating a multi-lingual system.

EDIT ASUBSCRIBE PAGE

* (General Information

Title
The Ethical Pets Gazzette

Language file to use
--default v

Intro

<h3=Subscribe to our newsletters</h3>|

Header

You can change the text in the intro too.

--default v

Intro

=h3=Subscribe to updates from Ethical Pets; news, reviews and
special offers=/h3=

The Header and Footer dialogues are used for html editing, and the
default code in them is taken from Config>Settings>subscription-ui settings.

We will discuss this further in the Subscribe page design and configuration
chapter.

You can edit the text in the Thank you page and Text for button too, however,
the standard texts are suitable for most situations so you may wish to just
leave the defaults as they are.

General Information: HTML or Text

The last section of the general information sections is on HTML Email choice. It
is very important and it directly affects the quality of your lists and the
subscribe satisfaction.

. BLINK
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You can create a HTML email in Blink Mailer, with images and other design
elements, and also a plain text version, with just text, no images, colours etc.
Some subscribers prefer only text, they may want plain text for technical
reasons, for example for compatibility with assistive software for a visual
impairment, or it may simply be a personal preference.

If you are planning on sending HTML messages you will want to avoid large
numbers of your subscribers accidentally signing up for text only emails. You
will have wasted time on a design they will never see and they may be less
interested in your mails.

It is therefore worth spending time on this section, deciding how you would
like to present the text vs. HTML options.

The default (as of version 3.0.11) is Offer checkbox for text, where the box
defaults to unchecked on the subscribe page. This means your subscribers will
have to manually choose to receive text emails, but the option is there for
those who need/want it.

HTML Email choice

' Don't offer choice, default to text
' Don't offer choice, default to HTML
® Offer checkbox for text

) Offer checkbox for HTML

' Radio buttons, default to text

) Radio buttons, default ta HTML
Display Email confirmation

® Display email confirmation
) Don't display email confirmation

If you intend to send emails in HTML format it is best to make the "path of
least resistance" be the signup for HTML. Many subscribers will ignore the box,
or may not know what HTML vs. text means.

Transaction messages

These are the messages sent to the Subscriber based on various actions, such
as subscribe and unsubscribe. The defaults are taken from
Config > Settings > transactional settings. It is possible to edit these, although
the defaults are suitable for most situations.

Select the attributes to use

This section allows you to choose which attributes, which personal/
demographic data, you will ask for from your subscribers on the page.

You might ask for generic information like name and city, or something more
specific, like shoe size or hobbies. The use of attributes is described in the
Attributes and Placeholders chapters.

e
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In this example we collected First Name and Last Name onIy and we did not
make either of them required because many people do not wish to give out
personal information. We had several other attributes to choose from.

ULE=IRE-T=1m20 L R LT T =)™ i)

* Selectthe attributes to use

Attribute: 1 Check this box to use this attribute in the page ¢
, First name

Mame:
_ textline

Type:

Default Value:

Order of Listing: Is this attribute required?: (]
Attribute: 2 Check this box to use this attribute in the page ¢
Merme. Last name

=l

The Type: is defined in the attributes editor. The Default value can be different
on each subscribe page if needed.

Please note that if a customer does not change the Default value when they
subscribe, whatever you set it as here will be added to your database.

Select the lists to offer
This final section allows you to select which lists to offer.

If you select only one list, then the subscriber will not be given a choice. If you
select multiple lists, then the subscriber will be able to select which lists they
want to join. In this example we chose only one list.

b Select the attributes to use

* Select the lists to offer
You can only select "public” lists for subscribe pages.

[ newsletter
Sign up to our newsletter

¥ The Ethical Pets Gazzette

Save Changes

:::'- BLINK
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Save your new page

AR BLINIC

Click the Save button at the end of the page when you are ready. You will be

able to edit the page again later if you want to make a change.

You will then be directed back to your Subscribe Pages list. We can now see

one page.

SUBSCRIBE PAGES

subscribe pages

SUBSCRIBE PAGES TITLE OWNER

DEFAULT ACTIVE
1 The Ethical Pets Gazzette admin O] v
© @]

View your page

To view your new subscribe page click the magnifying glass icon next to it on

your subscribe pages list (Config> Subscribe pages from the main menu).
D

hd

OWNER DEFAULT ACTIVE

;;

Al
Gazzette admin

Ld
e)|

C

S¢

' BLINK
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Your page will look something like this:

Subscribe to updates from Ethical Pets: news, reviews and special offers.

REGUIRED FIELDS SRE MSREEDS RED

Ernadl adcless

Confinm yvour emal addiess

# | prefer to veceive emals in Tewxt format

Last name

First name

Subscribe to the selected newsletters

Lnsubscrife

Use your page to add a subscriber as an admin

One additional functionality of the subscribe page view is to add a subscriber to
your database quickly, without needing to go into the administrative interface.
If you view the subscribe page while logged in as an adminiatartor, you will
see an additional box:

Subscribe to updates from Ethical Pets: news, reviews and special offers.

REQUIRED FIELDS ARE MARKED RED

@' You are logged in as adminiswrator [admin) of this phpList system
You are therefore offered the following choice, which your subscribers will not see when they load this page.

Go back to admin area |

Please choose:
') Make this subscriber confirmed immediately
'® Send this subscriber a request for confirmation email

Email address

This box allows you to add a subscriber by filling out the form on their behalf,
and you can specify if you need to send them a confirmation request or not.
This can be useful if you are talking to the new subscriber on the phone, for
example.

. B LiN K
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Setting up your list
categories

When you have more than a handful of lists you will need to organise them
into categories. You will be prompted to do this once you create more than 16
lists.

You can create categories to help you organise your lists at any time, and so
the exact method you should use depends on your situation. In this chapter
there are two suggested workflows.

1. Categories are set up before any lists are made (categories before lists).
2. Categories are set up to help organise pre-exisitng lists (lists before
categories).

You should follow the section most appropriate to your situation.

Categories before lists

To create your categories go to Config > Settings

System | Config | Info

Configuration

Scroll down until you find Segmentation settings
|

{ segmentation settings J

Categories for lists. Separate with commas.
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Enter the names of your categories, separated by a comma.

=TILT=

—[ segmentation settings ]

Editing Categories for lists. Separate with commas.

veganism, free software, gardening, environmentalism, chu

m——

veganism, free software, gardening, campaigns, church,
politics

In the image above you can see I have made a list category called veganism,
for example. This is because I know I will have several lists about veganism in
the future, for example, recipes, campaigning, events and philosophy.

NEXT, See the section about Using categories at the bottom of the page.

Lists before categories

If you use Blink Mailer a lot and you are using list segmentation you will soon
end up with more lists than you can easily manage without categorising. To
start categorising your lists go to Subscribers > Subscriber lists.

phpList :: phpList :: Subscriber lists = Mozilla Firefox x
File Edit View History Bookmarks Tools Help
JJ[@ phplList :: phpList :: S... x|+
e@ H“-d L - _EVC'| ))|E
=] Lcttll el L |
Eco Gardening iJ 4 0
&' O] & |
Vegan Events iJ 4 0
5 %) 0] @) |‘
vegan Fhilosphy S g 0
8 %) (0] &)
Free Software Events iJ C4 0
o) '8 O] 4|
Free Software Philosphy iJ 4 0
P PRI . |

Then click Categorise lists.
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Categorise lists

Add a list I

PUBLIC ORDER Suhe

If you have no categories at all yet, you will see the following screen:

CATEGORISE LISTS

Mo list categories have been defined

Once you have set up afew categories, come back to this page o
classify your lists with your categories.

Configure categories

Click Configure categories.

If you already have a few categories you will see a similar screen with the
Configure categories button (which you still must click) in the top right.

Create your categories

Add your categories, one by one, with commas between them.
]

SETTINGS

Editing Categories for lists. Separate with commas.

veganism, free software, gardening, campaigns

Save changes

Click Save Changes.

A BLINK
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Add lists to categories

Go back to Subscribers > Subscriber lists. Click the Categorise lists button.

MNavic)

Categorise lists

Add a list ‘

PUBLIC ORDER Suhe

Select the correct category from the drop-down beside each list.

If a list is already categorised, it will not be displayed.

3 Vegan Recipies veganism M
4 Eco Gardening .- Choose category :I
-- Choose category
veganism
5 Vegan Events free software
_ campaigns
B Wegan Fhilosphy = Choose category ¥

Carry on till all the lists are matched with a category if possible.

5 Vegan Events veganism -
6 egan Philosphy veganism -
7 Free Software Events free software -
g Free Software Philosphy free software M
g Grow your own food gardening N
10 Free Software - Techical free software -
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If you find a list that does not fit into a category you can keep it in
Uncategorised by leaving --Choose category in the dropdown and make a new
category later.

When you have finished click Save. Then, if you want to create more
categories click the Configure categories button at the top of the page again
and repeat the cycle.

If a list has already been categorised and you want to change the category,
you can do this by editing the list from the main lists page.

Using your categories

Once you have finished setting up categories, they should become part of your
everyday workflow with Blink Mailer.

For example, when you make a new list, you can assign it to a category during
the creation stage. In this image I have created a list called Vegan Recipes and
I can categorise it under veganism.

[
EDIT A LIST

List hame:

Vegan Recipies

M

Public list (listed on the frontend)
Order for listing

0

Category
veganism j

List Description

Also, as a second example of categories in use; when you send a campaign
you can look for your lists by using categories too.

lists

* Please select the lists you want to send your campaign to:

@ Veganlsm- ‘

« . Wegan Recipes (Private list)
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Using attributes

Blink Mailer is pre-configured to deal with some data about your subscribers,
for example email address, number of bounces (bouncecount) and their Blink
Mailer ID number: these are called system values. Attributes are used for any
other data you want to add to the system about your subscribers, usually
demographic information.

Some common attributes are Name, Age, Gender and City. Some bespoke
examples could be height, annual income, names of pets or kids and favourite
genre of book. The attributes you use are entirely up to you to decide.

Once you have collected/uploaded attribute data, it can be used to connect to
your subscribers more directly and with better precision, by using placeholders
and the segment plugin.

There are two ways to create attributes:

* Create them in bulk when you import a csv file
* Create them manually from the configure attributes page
» Edit them from the configure attributes page

This chapter will explain how to create attributes. How to use them is covered
by the placeholders chapter and the segment plugin documentation.

Creating Attributes when importing data

When you import complex data using the "csv with additional data" method,
attributes can be easily created (in bulk) from column titles which are not
already listed as an attribute.

Do not create new attributes for email and other system attributes, you must
map those to the pre-existing system attributes listed in the dropdown.

In the image below, five new attributes are being created, and EmailAddress is
mapped to Email.

Surname and Gender are standard attributes, however, the subscribers' height
in Centimetres is more unusual. Blink Mailer treats all these attributes in the
same way: there are no restrictions on the subject matter of an attribute.

AFFOREABLE MARKETING 3RECIAL ara pg 73



Growing and using complex lists

Import Attributes
IMPORT ATTRIBUTES SELECT
Title -- Creale new one v
GivenName -- Creale new one v
Surname -- Creale new one v
EmailAddress Email .
Centimeters -- Create new one v
Gender -- Create new one .
CONTINUE

Once an attribute has been created, any column headed with the attribute
name in future csv files you import will be mapped to the attribute
automatically. You will not need to create the attribute again.

SUMMARY MAFS TO
EmailAddress system; email
Title Title
Givenhame Givenhame
Surname surname
Centimeters Centimeters
Gender Gender

If there is new data for a pre-existing subscriber, it will be integrated into the
subscriber details by using email address or Foreign Key as a reference.
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= me

In the image below, for example, we have subscribers on the system already,
and now have added ShoeSize as a new attribute. Where our new dataset
provides a shoe size for a pre-existing subscriber, this new attribute data is

simply added to the details.

Title . GivenName

Giveniame N Surname

Surname

Centimaters — Gandaer

wlarshall

feralz

oa

Gender terenie Shoesize [UK)

Save chapoas et |

Creating and editing attributes on the Configure attributes

page

To create or edit an attribute manually,

attributes from the main menu.

stem Config | Info

Configuration
Settings

Manage plugins

Subscribe pages
Manage administrators
Import administrators
Configure administrator attributes

Bounce rules

Create, edit and change attributes for s

go to Config > Configure

From there you can create a new attribute:

e N N T R

Add new Attribute:

Name

Type:
textline v

Default Value:

Order of listing

Is this atiribute required?
v

Sawe changes

. BLINK

AFFORDABLE MARKETING SPECIALISTS
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You can also edit existing attributes:

FoAlroLe 3 Lentmelers

b attribute: 10 Gender

-~ attribute: 11 ShoeSize (UK)
Tag |/
Name:

ShoeSize (UK)

Type:
textline v

Default Value:

Order of listing:

Is this atiribute required? (]

Save changes Delete tagged amributes Merge tagged atwributes ‘ @

You can,

« Specify/change the name

 Choose/change the Type, which dictates the input method on your
subscribe pages (see the example edit below)

« Choose/change the Default Value, which dictates the standard value on
the subscribe page (you may need to change this on the Subscribe page
editor too)

 Make the attribute required, so subscribers must give the information in
order to sign up (warning: mandatory fields may deter subscribers)

Additionally you may,

« tag them to delete one or more attributes
» tag to merge several attributes together

ik
0
.
Z
N\
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Example edit 1: changing the type from textline to select

In this example we will change the Type of the attribute for ShoeSize, which
was automatically created during a csv file import, from textline to select. First
we change the type to select using the dropdown menu, then we click the Save
changes button at the bottom of the page.

= attribute: 11 ShoeSize (UK)

Tag ]
Name:

ShoeSize (UK)

Type:

select v
textline

checkbox

checkboxgroup

radio

hidden
textarea

Date
Order of histing:

i}

Then we click the edit values button which appears below the Type: dropdown.

Type:
select

Default Value:

We can then add all the shoe sizes we want.

If you are editing an attribute that already has data in the system, some
values may already be listed: if you try to add these again Blink Mailer will skip
them rather than create a duplicate, so you can simply list all the values you
want rather than search through.

CONFIGURE ATTRIBUTES

ShoeSize (UK)

Back to atributes Delete all

Add new ShoeSize (UK), one per line

(== B W RS R

ik
0
.
Z
N\
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You can change the order of the values for the attribute. This will affect the
order in which they are listed in the dropdown on the subscribe page. In this
example the shoe sizes had become jumbled because some were already in
the system and some were not, so we re-ordered them.

1 1
3 2
N 4
11 11
12 12
13 13
14 14

By changing the order, the choice given to subscribers when they sign up is
clearer.

' Make this subscriber confirmed immediately
® Send this subscriber a request for confirmation email

Email address |anna@phplist.com
Confirm your email address anna@phplist.com

¥ 1 prefer to receive emails in HTML format
ShoeSize (UK) 1 v

Sorry there are currently no 1 tters available

1
2
3
4
| Subscribe to the selected ne g E'
6

Unsubscribe 11

Using Attributes

The primary use of attributes is as placeholders. Please see the placeholders
chapter for information on how to use them. The segment plugin and
the attribute select plugin allow you to send emails to subscribers with certain
attribute values.
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Using placeholders

A place holder is a word in square brackets, for example,
[FIRSTNAME]

or

[UNSUBSCRIBE]

which will be replaced with real data, such as the subscriber's name or a
unique URL during sending.

Placeholders in Blink Mailer
There are three types of placeholder in Blink Mailer:

*System e.g. [UNSUBSCRIBE]
*Config e.g. [WEBSITE]
*Attribute e.g. [FIRSTNAME]

In this chapter we will deal with the Attribute placeholders only. We will deal
with system and config placeholders in the templating and configuration
chapters respectively.

Where to find a list of Attribute placeholders

When composing a campaign, you can find a list of placeholders by clicking on
the information symbol, i, next to the text Compose Message.

Content @
() Send a Webpgae

appse Message

Compose Messgge @L
‘ESnurce T gg% BlZ U :i=

10% of Sea Algae dog chews

Dear |

These Toothbrush treats are extra healthy, eco-fr
|| and completely vegan. They contain sea algae, wi
Any Attribute placeholders will be listed here along with instructions on how to
use them.

o
r.
Z
N\
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Dear [FIRSTMAME %% F riend],
and it will insert the FIRSTHNAME for those subscribers thal have this value, and “Frien
all others.

Currently you have the following atiributes defined:

Attribute Placeholder
First name [FIRST NAME]
Last name [LAST NAME]

To send the contents of a webpage, add the following to the content of the message:
[URL :http:ffwww. example.org/pathfto/lile. himl]

You can include basic user information in this URL . not attribute information:

These are generated directly from your chosen Attributes so if you wish to edit
them, please see the Attributes chapter.

How to use a placeholder in a mail

To use a placeholder, you need to type it exactly as suggested in the
information, i, box. This will include:

*an open square bracket
*the placeholder name (in Capitals, with spaces)
«and a close square bracket

It is also wise to use some fallback words, that is words that will be inserted in
place of the data when the data is missing. You can indicate the fallback
words with the double percent sign %%. Anything before the %% is the
attribute placeholder. Everything after the %% is the fallback text. The fallback
text is optional.

In this example, the placeholder would either print the subscribers' first name,
and where the name is not known, it will print the word Friends.
COTTETIT

. Send a Webpage '® Compose Message

Compose Message @
H = I D g=— E=— =
JiEsrce @@ LB 7 UiE !

3

10% of Sea Algae dog chews

Dear [FIRST NAME%%Friends]

and completely vegan. They contain sea algae, which has a high

concentration of chlorophyll, proteins, iron, Omega 3 and Omega 6 fatty <
acids and a rich sonrce of vitaming  These vimmy treats: L

A BLINK
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It is important that you test your placeholder before you send your mail, as
mistakes are ugly and disconcerting for your subscribers.

Set up two test accounts
To test your placeholder effectively you will need:

« one subscriber profile suitable for testing the attribute placeholder. You
can use an alternative email to which you have access, where the
attribute data is completed

« another subscriber using an email you have access to, where the
attribute data is not completed.

You may need to add these emails or edit your existing data to achieve this.
You can do all these things from the Search > Search Subscribers page.

In the example below I have subscribed myself to the system using my
personal email (rather than my work email) and I have filled out my name.

LR LA LL LR

First name
Anna

Last name .
Morris

____Which ethical issues are vou nassionate about?

And I have another one using my old email address where the attribute data
has not been provided.

T OTeIgIT ey

First name

Last name

L_Which athicaliccuac ara vau naccionato ahout?

Send a test message

Next, enter the two test emails into the Send Test box at the bottom of your
campaign Content page and press Send Test. You may need to confirm the
emails if it is the first time you have used them.

' BLINK
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Check the results

For the subscriber where the attribute related to the placeholder has data, you
should see that data in the email. In this example you can see the name Anna
is visible in the place of [FIRST NAME]

uke

® Reply | = Forward | & Archive

From Me <info@ethical-pets.co.uk> 7
Subject Special Offer on Sea Algae dog chews

To = = m w pyegey g m— 7

Lihical Yot

10% off Sea Algae dog chews

Dear Anna

These Toothbrush treats are extra healthy,
eco-freindly, entertaining and completely vegan.
They contain sea algae, which has a high

Where the subscriber has no data for the attribute, you should see the Fallback
Text. In this example that is the word Friends.

éciaL Offer" on Sea.:ﬁLae dog chews

| N .| P 1
# Reply = Forward & Archive J
From Me <info@ethical-pets.co.uk> .-/
Subject Special Offer on Sea Algae dog chews

To Me <info@ethical-pets.co.uk> .0

Ethical Pet®

10% off Sea Algae dog chews

Dear Friends

These Toothbrush treats are extra healthy,

arnJdraindAl: gntgrainina and s omnletaly yanan

You can now send your campaign as usual.
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Targeting the campaighs:
list segmentation

In this example, Ethical Pets are sending out a campaign about a special offer
on dog treats. They are targeting the campaign by only sending it to
customers who have previously bought products for a dog.

There are several reasons for doing this:

+ It enables more campaigns to be sent overall, which increases the
impact of email marketing

* Most people will receive fewer campaigns, so they are not inundated

+ Campaigns will be more relevant to readers

+ Campaigns are quicker and easier to write, because they only need to be
interesting to the target audience and not to everyone

+ It is easier to measure the impact of the campaign

In this campaign only 35% of the total number of subscribers were emailed.
Without segmentation either a large humber of people would have received a
campaign with little relevance to them or Ethical Pets would have needed to
spend time tying to make the campaign have a broader appeal.

The overall consequences of segmentation should be:

* Happier customers

* Fewer unsubscribes

* More motivated marketeers

 Improved sales/responses to calls to action
 Improved customer loyalty/retention over time

Segmenting your list

The method of segmentation depends on,

* The quality of your data
* Where and how your data is stored
What tools you have to segment it
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In this example the segmentation was achieved using a Prestashop plugin,
which allows the exporting of customer details based on the category of
product bought.

Collapse All | Expand All | Check All | Uncheck All |

IEIf‘1 Animal (1 Selected)
=@ Dog
: --r‘1 Dog Food
.~ Dog Treats
f“' Dog Accessories
f‘* Dog Collars
: f‘\ Health and Grooming
B0 Puppy
- E-0 cat
-7 small Animal
. B0 Wholesale
--f‘W Ethical Issues
&0 Special Offers

B w0

By supplier By

Unfortunately the Prestashop core does not provide very detailed data exports,
and so a paid plugin was needed.

In other situations it may be possible to segment a list using:

» spreadsheet software
« database software
« the Blink Mailer segment plugin, to split the list using attributes

Adding a segmented list to Blink Mailer
A suggested methodology for adding a segmented list to Blink Mailer is:

* Synchronise your data - upload any new subscribers to Blink Mailer

* Create a new list

« Copy and paste the segmented emails into the new list

« Blink Mailer will pull in the rest of the data/attributes for you from the
subscriber profiles

Having synchronised the data by uploading the latest data using a csv import,
Ethical Pets went on to create a new list.

. BLINK
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In this case a new list Dog category purchasers was created (note: a private

list, not public)

EDIT A LIST

List name:

Dog category purchasers

]
Public list (listed on the frontend)
Order for listing

List Description

Internal list, people who bought from category dog as of 17/1/14

IMPORT SUBSCRIBERS BY CUT-AND-PA

Adding subscribers Dog category purchasers

Please enter the emails to import, one per line, in the box beloy
Emails"

¥ Check to skip emails that are not valid

ort e

BLINK

AFFORDABLE MARKETING SPECIALISTS

Then the emails from the prestashop segmentation export were pasted in:
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| Tag all users in this page

Members

Listing 1 to 50 of e seme—— eooe
TAG

MEMEERS

N O N N u

(it B

[ o e

Sending to a segmented list

The process for sending to segmented lists is the same as sending to large,
unsegmented lists. You simply select the list on the Lists tab of the campaign
workflow. In this example we have put the segmented list in a category too.

lists

* Please select the lists you want to send your campaign to:

‘ i@ | Dog related segmentations

. ¥ Dog category purchasers (Private list)
Internal list, people who bought from category dog as of 17/1/14
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Excluding a list

If you are sending a lot of mails and there is a chance that subscribers are in
multiple segments and receiving lots of campaigns, you could consider using
the exclude list functionality.

For example, if Ethical Pets wants to send a campaign to a list of cat product
purchasers just a few days after they sent the email to dog product
purchasers, they could exclude anyone on the dog list from receiving the cat
related campaign.

While this involves prioritising which campaign is most important, the dog or
the cat one, it means that the people who buy both dog and cat products are
not receiving too many campaigns in total.

Activate the list exclude feature

Please contact Blink and ask us to activate this service within your config.php
file.

Using the list exclude feature

In this example, Ethical Pets have sent an email to the cat product purchasers
segment but excluded the dog purchasers segment. During sending Blink
Mailer checks if the subscriber on the cat list is also on the dog list, and if they
are, the email is not sent to them.

SEND A CAMPAIGN

lists

= Please select the lists you want to send your campaign to:

@ Uncategorised | Cat related segmentations | Dog related segmentations

« ¥ Cat product purchacers (Private list)

* Please select the lists you want to exclude from this campaign

i@ Uncategorised Cat related segmentations | Dog related segmentations

« ¥ Dog category purchasers (Private list)
Internal list, people who bought from category dog as of 17/1/14

#. BLINK
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Additional ways to segment a list
Here are a few ideas for ways you could segment your lists:

Subscriber location

Subscriber interests

Subscriber demographic (gender, age, shoe size etc)

Subscriber actions (purchase, abandoned cart, signed petition, recent
comment etc)

Subscriber status (new to list, long-time member)

Subscriber preference: ask your subscribers how often or when they
would like to receive emails from you using an attribute on your
subscribe page.

Additional benefits of segmentation

There are many benefits to list segmentation:

You can a/b test aspects of your email, for example the tone / style /
grammar of the subject line

You can automate transactional messages, for example, messages
offering help to customers who abandoned a cart. You can use a
recurring campaign for this.

You can tailor very specific emails, for example about events, to those
who live in the location of those events.
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Designing and assessing

your campaigns

CKEditor Interface

CKEditor provides a clean and simple user interface. If you are familiar with
desktop word processors like Microsoft Word or OpenOffice.org Writer, you will
quickly see that using an online text editor is just as easy and intuitive.

Interface Structure
The figure below shows main building blocks of CKEditor:

Bswce BD R @ B |2 " BEE « »| Qb B Y
ERCRCH =R =] 1)

(B I US x x|L
=iz E 9 '3}:|E§ = §|.1¢ B o o M
HOEE®Q =

This is the CKEditor interface

(2)

oty o (4) ‘

The interface of CKEditor

¥ Cut
e (3)

(@ Paste

i
u
.
Z
A

o0
L L
(L1} -
8 - 89
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The editor consists of five main parts:

* Toolbar (1) - the section at the top of the editor containing grouped
menu buttons that give you access to various functions of CKEditor.

» Editing Area (2) - the space below the toolbar where you type your text
and add media.

« Context Menu (3) - a small pop-up menu with shortcuts to most
common operations available for the object, visible after a right mouse
button click or pressing the Application/Menu key on your keyboard.

+ Elements Path (4) - the section at the bottom of the editor displaying
information about the HTML elements of the document (advanced
feature).

» Dialog Windows - small pop-up windows that appear when you use some
of the editor's functions and are opened by clicking the toolbar buttons.

Resizing and Maximizing CKEditor

CKEditor is usually embedded in a website, as one of its parts. If, however,
you would like to resize its interface, you can easily do it by clicking and
dragging the resizing grip in the bottom right-hand corner of CKEditor
interface.

To make writing more convenient, you can also maximize the CKEditor
interface in the browser window. When you press the Resizing and Maximising
CKEditor toolbar button, the CKEditor interface will fill the browser window and
stretch to its borders. If you want to return to the default view and minimize
CKEditor, press the same button again.

CKEditor Toolbar

The Toolbar is the section located at the top of the editor window. It contains
menu buttons that give you access to various functions of CKEditor. All buttons
are grouped according to their function and include both simple operations
(like basic text styling or formatting) and more advanced features (like
inserting media or forms via a dialog window).

This is what the editor toolbar looks like:

Bswee DR @ B|[x 0 @B B « »|[Q b E| %]
ERODUD =

[B LanUa S pitlT.
2kl nlz 2 =Pl |l s m]
HOMmMEGCQE®

Lowe - Jems J[ron o |2 @[5t ][ 2]
The CKEditor toolbar

:EE;
8
0
r.
Z
N\

L
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The CKEditor toolbar buttons are illustrated with meaningful icons. If, however,
you are not sure what functions they perform, hover the mouse cursor over
the buttons to see a tooltip with the name of the function.

Using the Toolbar

In order to perform an operation assigned to a button, click the button once. In
most cases it will either immediately perform some predefined action or open a
dialog window with further configuration options for a feature.

Remember that the toolbar can also be used with your keyboard. To enter the
toolbar, use the Alt+F10 keyboard shortcut. To move to the next or previous
button group, use the Tab and Shift+Tab keys, respectively. Within a button
group, use the Left Arrow and Right Arrow keys to move between buttons of
this group. To activate a selected toolbar button, press Enter or Space.

A

The accessibility shortcuts for toolbar navigation were modified in CKEditor 3.6,
when the concept of a toolbar button group was initially introduced. On
entering the toolbar you can now use the Tab and Shift+Tab shortcuts to
navigate between button groups and the Arrow keys to navigate between the
buttons within a group. In CKEditor 3.5.x and before both Tab and Arrow keys
were used to navigate between the toolbar buttons.

Some of the buttons serve as placeholders giving you access to further options
placed in a drop-down list. They are easily recognizable thanks to a small a
icon on their right. Clicking the name or the arrow icon of such button expands
the list and lets you choose one of its options via the left mouse button. To
select a drop-down list option you can also use the Tab or the Down Arrow key
and then accept your choice by pressing Enter or Space on your keyboard. To
hide the list, use the Esc key or click anywhere in the browser window.

Collapsing and Restoring the Toolbar

To save on screen estate, you can collapse the toolbar by pressing the =
button or using the Alt+- (minus) keyboard shortcut. In order to return to the
full toolbar view, press the same button or keyboard shortcut again.

Editing Area

The Editing Area is the empty space below the editor toolbar where you type
your text. All formatting applied using the toolbar buttons as well as all
inserted media appear immediately in this area.
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This is what the editing area looks like after you type some text:

Bswce @D R @ B|[%x0 BGEGE « »|[Q bt E| S
R =R = RN

[Bl: us <z

iz 32| |9 o I e
HOmMEOQE®

(e Jrems Jron ] o= -][a- @] &) 7]
This is the editing area

body p strong F

The CKEditor editing area

If the document contents span beyond the limits of the editing area, a
standard scrollbar will appear. To view the text that exceeds the size of the
editing area you can either scroll it using the scrollbar or maximize the editor

in the browser window using the @ button.

WYSIWYG Editing

CKEditor is a WYSIWYG editor, which means that the text edited in it looks as
similar as possible to the results end users will see after the document gets
published. When you format your text using the editor features, the formatting
can be immediately seen in the editing area.

This is some sample text. This text was written in CKEditor.

¥ In WYSIWYG editors all text formatting is immediately seen in the editing area.

body p span span

Formatting seen immediately in the editing area

Navigating the Editing Area
To easily move around the text you can use the keyboard.

Page Up and Page Down let you jump up and down the text. The Home and
End keys can be used to go to the beginning and end of line, respectively, or
combined with the Ctrl key — to the beginning and end of the document. You
can also move inside the text using the Arrow keys.

e

# BLINK

AFFOREABLE MARKETING 3RECIALIETS pg 92


http://docs.cksource.com/File:CKEditor_maximize.png

Designing and assesing i Lt B Lm

Context Menu

The Context Menu is a pop-up menu that appears whenever you click inside
the CKEditor editing area with the right mouse button, use the Menu /
Application key on your keyboard, or the Shift+F10 keyboard shortcut. It
serves as a shortcut for most common operations available for a given type of
object.

The image below presents the context menu for a link embedded in the
document:

This is some sample text

You are using CKEditor.

£ Unlink

CKEditor's context menu for links

The menu is context-sensitive which means that the options displayed in it
depend on the object that you click.

If, for example, you press the right mouse button while inside a table, you will
see some table-specific options available in its context menu.

O o O
First Name Surname
i John Troll—
Mary Smit| #  CU
Alexander Pind Bg Copy
- i Paste
Cell ' Insert Cell Before
Row + Insert Cell After
Column + Delete Cells
Delete Table Merge Cells
[7] Table Properties Merge Right

Merge Down
Split Cell Horizontally
Split Cell Verically

. Cell Properties

CKEditor's context menu for tables

Note that for some more complex objects, like a table, the context menu might
include sub-menus with further options. To open the sub-menu, go to the
menu option containing a small right-pointing arrow () and either click it with
your mouse or use the Right Arrow key on your keyboard. To return to the

# BLINK
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parent menu, use your mouse or the Left Arrow key.

To perform an operation listed in the context menu, click it with the left mouse
button. You can also move up and down the context menu with the Up and
Down Arrow keys or the Tab and Shift+Tab combinations. Once an option is
highlighted, you can activate it with the Space or Enter button. If an option is
grayed out, like the Cut and Copy operations in the first screenshot, it is
unavailable unless some pre-conditions are met (e.g. an element is selected).
A

In some environments and browsers clicking the right mouse button results in
the browser context menu covering CKEditor context menu. If this is the case,
press the Esc key once to close the browser context menu and reveal the
CKEditor menu hidden below.

Elements Path

The Elements Path is the section at the bottom of the editor displaying
information about the HTML elements of the document for the position of the
cursor. It is an advanced feature aimed at users who want to have more
control over the source code of their document.

The elements path always shows a hierarchy of HTML elements for the
currently selected element of the document.

This is what the elements path looks like:

Bswce BD R @B/ % BEE «~|Qt B g
BERPOeDLD = I

l:: = dE |9 W ié%i&m gv][@@;p]
HOMEOQ Q= ®
lstylers -”anal -HFom -”sm -H_&_, - || 52

This is the editing area

body p strong A

The elements path of CKEditor

The mouse cursor is now located inside the word "Second", so the elements

:EE;
"3
0
r
Z
N\

L
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path shows the following hierarchy of HTML elements: body (main document
element), ol (ordered list), li (list item) and strong (bold font).

Note that most of the same information can also be deduced from the state of
the main CKEditor toolbar since the formatting options that were applied to the
active element are highlighted.

CKEditor elements path can also be used to select elements. To achieve this,
click an element's name on the elements path with your mouse. You can also
use the Alt+F11 keyboard shortcut to enter the elements path, and then
navigate between the elements with the Tab and Shift+Tab (or Left and Right
Arrow) keys. To select an element with your keyboard, use the Enter or Space
keys.

Dialog Window

Dialog windows are small pop-up windows that are displayed when you use
some CKEditor functions like Find and Replace or Insert Image. These windows
display various configuration options related to a particular feature and often
give you access to more advanced settings.

Dialog Window Structure

As an example, the Anchor dialog window is presented below:

=== |ww & PIEHAE @ OIZ @

El Source 0@ B 4#BE@@G &%¥% «r B B o6HF 0 EHE o =b
- - AT @ B3 4

B I U & X, x2  i=
Styles > Mormal > Ford . Size

Anchor Properties .

Anchor Name

| |
ook (cEE

body p A

Anchor dialog window in CKEditor

When a dialog window is open, the main editor window including the toolbar is
blocked.

All dialog windows contain the OK button that lets you confirm the settings and
return to the main editor window as well as the Cancel button that closes the
pop-up window without introducing any changes to the document.

Another way to close the dialog window and return to the editing area is to use
the X button located in the top right-hand-side corner of the window or to
press the Esc key on your keyboard.

Depending on the options available for a particular feature the dialog window

:EE;
0
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Z
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may contain different elements. Some windows may also contain tabs with
additional configuration options. To navigate between the tabs simply click
their labels. You can also move between tabs with your keyboard. To enter the
tabs list, press the Alt+F10 shortcut while in the dialog window. To move to
the next tab, use the Tab or Right Arrow key. To go back to the previous tab,
press Shift+Tab or the Left Arrow key.

Reopening a Dialog Window

Some dialog windows can be used to insert an element, such as an image or a
table, into the document. After an element is added to the document, in most
cases it can be edited at any time by double-clicking or selecting it and clicking
the appropriate toolbar button again. The dialog window will re-open and you
will be able to introduce changes to the element's configuration options.

If you attempt to close the dialog window without saving the changes, you will
be prompted to do so:

e Some of the options have been changed. Are you sure to close the dialog?

ok | cancel |

An alert window prompting to save the changes made to an element

You can either proceed without saving your changes by choosing OK or close
the alert window with the Cancel button and save the changes.

Resizing a Dialog Window

CKEditor dialog windows all open with some default size. If, however, you
would like to resize a dialog window, you can easily do it by clicking and
dragging the resizing grip in the bottom right-hand corner of a dialog window.

The image below presents a default size of the Advanced tab in the Link dialog
window.

L
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Link ®

LinkInfo Target Upload Advanced

Id Language Direction Access Key

| | =not set=

Mame Language Code Tab Index

| | | | | |
Advisory Title Advisory Content Type

| | | |
Stylesheet Classes Linked Resource Charset

| | | |
Relationship Style

*_4

Advanced tab of the Link dialog window in its default size

Since the text entered into some text fields (particularly the Style field) might
be longer than their default size, you may wish to resize the dialog window.
Use the Drag to resize feature to change the width and height of a dialog
window as needed.

Link ®

LinkInfo Target Upload Advanced

Id Language Direction Access Key
| | | =notset~

Mame Language Code Tab Index
Advisory Title Advisory Content Type

Stylesheet Classes Linked Resource Charset

Style

*_,g

Advanced tab of the Link dialog window after resizing

A BLINK
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Editing tools

Bswce BD R @ B XD @G @ « ~| Q% E %
EER=IELEY _

B NS % x|TL]

BRI B 2y
HOMmMEO Q=6

R rrn

l- Styles - ] l Normal -”l

Below you will find an overview of all features available in the default
CKEditor toolbar as per above image. The CKEditor allows you to design your
email campaigns with its various tools. For more information about each tool
please click on the link in orange found to the right of the description.

Working with a Document

Button |Description
Bl View or edit the source code of the document (for advanced

users). See Document Source.
Save the contents of CKEditor and submit its data to the server,

= when CKEditor is placed inside an HTML form. See Saving
Content.

0 Clear the editing area and create a new page. See Creating a
New Page.

R Show a preview of the document in the shape that will be
displayed to end users. See Document Preview.

B Select a layout template. See Templates.

b 4 Cut the selected text fragment to the clipboard. See Cut.

) Copy the selected text fragment to the clipboard. See Copy.

& Paste content copied to the clipboard along with formatting.
See Paste.

& Paste content copied to the clipboard without formatting.
See Paste as Plain Text.

@ Paste content copied from Microsoft Word or similar applications

' along with formatting. See Paste from Word.

(=] Print document contents. See Printing.

- Insert a page break. This only impacts the printed version.

B See Page Breaks.

- Check spelling of the document text or turn on the Spell Check
As You Type (SCAYT) feature. See Spell Checking.

A BLINK
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*@
[ ]

Undo or redo the most recent action performed. See Undo and
Redo.

Find a word or phrase in the document. See Find.

Find and replace a word or phrase in the document.
See Replace.

Select all contents of the document. See Text Selection.

|
x

Remove the formatting of the selected text. See Remove
Format.

LT ]
'y

Maximize the editor in the browser window. See Resizinag and
Maximizing CKEditor.

Highlight all block-level elements in the document. See Show
Blocks.

Show information about CKEditor. See CKEditor Version.

Text Styling

Button

Description

Bislaull S

Apply bold, italic, underline or strike-through formatting to the
text. See Bold, Italic, Underline, and Strike-through.

X, x*

Apply superscript or subscript formatting to the text.
See Subscript and Superscript.

Styles -

Apply pre-defined combinations of various formatting options to
block and inline elements. See Formatting Styles.

Apply pre-defined block-level combinations of various formatting
options. See Paragraph Format.

Change the typeface of the text. See Font Name.

Change the font size of the text. See Font Size.

Change the color of the text. See Text Color.

Change the background color of the text. See Backaround Color.

Text Layout

AFFORDABLE MARKETING SPECIALISTS

Button |Description
i Increase or decrease text indentation. See Text Indentation.
79 Format a block of text as indented quotation. See EBElock Quote.
i Create a new div element in document source. See Creating Div
“ Container.
== = = Set text alignment (left, centered, right or justified). See Text
Alignment.
AR, BLIN K
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Set text direction as from left to right (default value for most

e . Western languages) or from right to left (languages like Arabic,

Persian, Hebrew).

= Insert a divider line (horizontal rule) into the document.

- See Horizontal Line.

Rich Text
Button |Description
= o= Create a numbered or bulleted list. See Creating Lists.
Create or remove a hyperlink in the text. These features may
! also be used to manage file uploads and links to files on the web

server. See Links, E-Mails and Anchors.

- Insert a link anchor to the text. See Anchors.

L Insert an image into the document. See [nserting Images.

o Insert an Adobe Flash object into the document. See nserting
Flash.

= Create a table with the defined number of columns and rows.
See Creating Tables.

® Insert an emoticon image (smiley or icon). See Inserting
Smileys.

o Insert a special character or symbol. See [nserting Special
Characters.

® Insert an inline frame (iframe). See Inserting [Frames.

Form Elements

Button |Description

& Insert a new form into the document. See Creating Forms.

Insert a checkbox into the document form. See Checkbox.

@® Insert a radio button into the document form. See Radio Button.

OJ Insert a text field into the document form. See Text Field.

O Insert a multi-line text area into the document form. See Text.
area.

o Insert a selection field into the document form. See Selection
Field.

= Insert a button into the document form. See Button.

= Insert an image button into the document form. See Image
Button.

7 Insert a hidden field into the document form. See Hidden Field.

AFFORDABLE
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Templates |

The templating system in Blink Mailer is designed to create a workflow that
keeps things simple for the campaign creator.

The Templating Workflow in Blink Mailer
There are two elements to the workflow:

1. Creating and uploading a template; this is done very rarely
2. Choosing and using the template; this is done for every campaign

Step one is the more complex and it is often done by a web designer or system
administrator. We cover this in the creating a template chapter. There is also
a really easy templates chapter to help you if you do not have a designer.

The second part of the workflow is very simple. The person creating the
campaign simply selects the template by name from a drop down menu after
the campaign message has been written.

The template is then applied during sending, like a wrapper around the text,
and the person sending the campaign does not come into contact with the
template code at all.

The template is not applied to emails sent to subscribers who request a plain
text email.
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An infographic about templating in Blink Mailer

Templating in Blink Mailer

One time

LN

BLINK

Select your template

phpList 3.0.7 released - and a new manual is on the
way!
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Campaign text is wrapped in template
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The footer

The Blink Mailer footer
« Is an active feature of the software, not simply a description of a design

element

 Can be edited for each campaign from the content tab of the campaign
workflow

« Is replaced by a secondary footer when the Forward to a Friend system
is used

* Should contain the [UNSUBSCRIBE] placeholder
« Is placed in the template with the [FOOTER] placeholder

What is the footer?

In your template design you may have many elements which you think of as
being "the footer." In the image below, for example, the blue and black
coloured areas and all the content within them would commonly be described
as the "footer."

However, you may not wish to add all of this into your Blink Mailer footer. For
example, in the image below only the "update your preferences" and
"unsubscribe" elements are within the Blink Mailer footer system. The rest is in
the template itself.

the phpList team

L f

Try phpList hosted - it's Free! Follow us on twitter Like us on Facebook

Jpdate your preferences : Unsubscribe

You may wish to choose which items go into the Blink Mailer footer carefully
because:

« The footer can be edited from the campaign composition tab: you may or
may not want certain items to be edited on a campaign-by-campaign
basis

« If the forward to friend placeholder is used, all content in the Blink Mailer
footer will be replaced when the message is forwarded.

o
r.
Z
N\
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Adding your footer

Everything that goes in the Blink Mailer footer is added separately from the
rest of the template.

To situate the footer to your template use the [FOOTER] placeholder.

=/tr=
</thody=
</tables]
[FOOTER] =br /=
[SIGMATURE] =/div=
=/div=
=!-- END TEMPLATE --=

HTML v~  Tab

You should design your footer as a separate .html file

File Edit View Search Tools Deocuments
I:J !E}Chmn ~ E&]Smm | E;

I|II @ phplist-newsletter-footer.html X 1' >

=) Unde & | “ ~

<!-- START [FOOTER]--=

<table bgcolor="#S6A3DZ2" style="margin:Gpx
aUto;color:#666; " width="100%" cellpadding="5"=
=thody=<tr=

<td>&nbsp;</td>|

=td sty1e=“paddingTl@px;font—size: 15px; font-
family: Arial ,Helvética,sans-serif; line-height:
1.3em; text-align: left; vertical-align:bottom"
wvalign="bottom"=

<11 style="list-style:none;color:#2C2ZC2C;margin-
bottom:5px"=<a href="http://community.phplist.com/
Lsers/" style="font-weight: normal; color: #FFF;
text -decoration: none;color:#2C2C2C"=Join the
community ! </a=</li=>

<11 style="1list-
style:none;color:#FFF;margin:Opx"=<a href="https://
vt . phplist .com/hosted" title="phplist.com/hosted"”
style="font-weight: normal; color: #FFF; text-
decoration: none;"=Try phplList hosted -

it 'stnbsp;Free!l</as</11=>

o |

HTML v  Tab Width: 8 v Ln 5, Col 16 INS

To add your footer to Blink Mailer go to Config > Settings and campaign
settings
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The default HTML template to use when sending a
message

Default footer for sending a campaign

=div class="footer" style="text-align.left; font-size; 75%;"=
=p=This message was sent to [EMAIL] by [FROMEMAIL]</p=
=p=To forward this message, please do not use the forward

L—_J message

r‘h Default footer for sending a campaign

-

=a href="[FREFERENCESURL]" title="Update your
preferences"=Update your preferences</a= | <a href="
[UNSUBSCRIBEURL]" title="Unsubscribe" =Unsubscribe</a=

|' Z | Footer used when a message has been forwarded

=div class="footer" style="text-align:left; font-size: 75%,"=

<.tab|e>

<|-- END [FOOTER]--=|

Savechangﬂa
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Footer @'

<|- START [FOOTER]-—=

<table bgcolor="#56A302" style="margin: 0px auto;color #666," width="100%:" c4
<tbody=<tr=

<td=&nbsp;<1d=

<td stvle="padding:10px:font-size: 150w font-familv: Arial Helvetica. sans-serif; |

Save as draft Save and continue editing

Send test

As well as in your campaigns when you send them
the phpList team

L f

Try phpList hosted - it's Free! Follow us on twitter Like us on Facebook

Jpdaie your preferences - Unsubscribe

The Forward to Friend footer

On the Config > Settings page, there is a second footer called Footer used
when a message has been forwarded.

If you use the [FORWARD] placeholder, and a subscriber forwards the email,
this footer will replace the usual one. It contains the following text:

This message has been forwarded to you by [FORWARDEDBY].
You have not been automatically subscribed to this newsletter.

If you think this newsletter may interest you, you can [SUBSCRIBEURL] and
you will receive our next newsletter directly to your inbox.

If you wish to use the forward to friend system you should edit this footer so
that it has the correct appearance while maintaining the appropriate text.
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Creating a template

Creating your template
There are lots of ways to create your template. You could

« Design and write your own

« Pay someone to do this for you

 Modify a generic/Open Source template that you have bought or
"recycled"

« Use the super-simple DIY template in the next chapter.

Here are some tips to help you set up your template for use with Blink Mailer.

If you don't understand the information in this chapter and you don't have
anyone to help you with your template, then skip to the next chapter for a
super simple template.

The Basics

You should use inline styles, and unless you have configured Blink Mailer
especially with a plugin, you must use a single column template.

If you choose a responsive template, your campaign editor should not use
images with a width larger than a smartphone screen (max 320 by 480 pixels).

The footer in Blink Mailer is quite specialised and is described in a separate
chapter. If you plan to have a footer in your design, please read the footer
chapter before you start work.

Logo: upload or remote link?

When you are designing or modifying your template, you need to decide if you
will include your logo in the campaigns as an attachment or use a remote
image. If you include your logo as an attachment it will always display to the
recipient.

Forward this message

phpList 3.0.7 released - and a new

o o 2 p e gl

If you use a remote link, however, the image will only display when the
subscriber gives permission (in most email and webmail clients).

A BLINK
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To protect your privacy, Thunderbird
E has blocked remote content in this Preferences | *
message.

Forward thiz message

phplist.com

nhnl iet 2N 7 ralaacad - and a neawa

If you decide to upload your image then leave the local link (or just a use a
"broken link") and you will be prompted to upload the image when you are
adding your template to Blink Mailer.

A mandatory placeholder in the body

You must include some strings that Blink Mailer will replace during the sending
stage.

[CONTENT]

The obligatory string is [CONTENT]. This will be replaced with the content of
your message when you send your campaign.

table wldth="1U0%" cellspacing="uUpx cellpadding="
<tbody=
=tr=
=td style="font-size: 1dpx; font-family
=hl style="font-size: 1.8em; margin: le
[CONTENT] =/td=
=/tr=
=/thody=
table=

|

Adding your template to Blink Mailer

To add a template to Blink Mailer, go to Campaigns > Manage campaign
templates from the main menu.

) L1 I N,

5 Campaigns Statistics Systerm  Config Info
Send a campaign
List of campaigns

View and manage campaign templates, that are used to send out HTML emails

"
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You will then see a list of templates already in the system. By default there is
one template, the system template (which styles things like the confirm
subscription emails).

MANAGE CAMPAIGN TEMPLATES

Existing templates

EXISTING TEMPLATES 1+] CAMPAIGN DEFALULT SYSTEN

System Template 1 ] 2]

PPN

|ﬁu:|d or edit a campaign template|

Click Add new template.

Name your template

First, give your template a Title. This will display in the list of templates to
choose from during the campaign composition stage, so it is important that the
name makes sense to the person writing the campaigns.

In this case we called the template Blink Mailer announcements, because it is
the template we use when we announce a new version of Blink Mailer. We
have different templates for community news and Blink Mailer hosted special
offers, for example.

List of tempkates

—_—

Title of this tamplate | phpList announcements

Content of the template .
The content should at least have [CONTENT] somewhere.
fou can upload a template file or paste the text in the box below

Templae file. Browse... phplist_template.html

phpList _template.html

Upload your file

To add your template you can paste the html into the editor, or upload it as a
file. In this example we are uploading it.

Click the Browse button, locate the template file on your computer and
click Open. The file name will then appear next to the Browse button (as
shown in the image above).

ik
0
.
Z
N\
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Scroll to the bottom of the page and click Save changes, using the checking
tools if you wish.

Save your template

Checlk that all links have a full URL M

Check that all images have a full URL

)

Upload your logo?

The next screen gives you an opportunity to upload your template images, if
you have any. This will usually be a logo. In this case the logo is hosted
remotely and so no image is listed to upload.

ADD OR EDIT A TEMPLATE

Images

Below is the list of images used in your template. If an image is

This includes all images, also fully referenced ones, so you may
be included in the campaigns that use this template.

Click Save images.

Your template will now be added to your list of Existing templates.

If you wish to set this template as the default for all campaigns, you can check
the button under CAMPAIGN DEFAULT.

MANAGE CAMPAIGHN TEMPLATES

Existing templates

EXISTING TEMFLATES D CANPAIGN DEFALLT SYSTEN

phpList announcements 1

8

Defaults and settings

S BLINK
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There are some default settings for templates and footers at Config > Settings
under campaign settings.

For example you can choose which template will be used by default by
referring to its ID.

v

o

Default footer for sending a campaign

| o TaADT [T

The ID of the template can be found next to the template name when you go
to Campaigns > Manage campaign templates from the main menu.

MANAGE CAMPAIGN TEMPLATES

Existing templates

EXISTING TEMPLATES 1¥]

My MNewsletter Template 1

Add new tem plate | Add default system tem plate

Using your template

During campaign composition, use headings and other formatting as normal.

You do not need to apply any additional styling such as text colour, if those
elements are dealt with in your template.
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phpList 3.0.7 released - and a new I
the way!

The phpListteam is pleased to announce a newversion of phpList, 3.0.7. ]
visit our blog here.

Highlights
Here are some of the more notable changes in the new version. Forafull |

Edit a sent campaign

Back by popular demand is the option to edit a campaign that is active or h

In the Format of the send campaign workflow, select your template from
the Use template dropdown.

3
Format

SEND A CAMPAIGN

format

Send as @
HTML © text

Use template @
phplist announcements j

Save as draft | Save and continue editing ‘

The template and theme are then applied during sending.

@ phpList.com

ﬁ]héoLlst 3.0.7 released - and a n}

The phpList team is pleased to announce a new versi
full story, please wisit our blog here.

Highlights

Here are some of the more notable changes in the ne
see the changelog.
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Advanced templating

More template placeholders

This chapter contains additional details that may be useful for a designer who
is creating a template for use in Blink Mailer.

[SUBJECT]
[SUBJECT] adds the subject of the email within the newsletter text.

[CONTENT] - a mandatory placeholder

This is where the message's content (body) will be inserted. Every template
must have a [CONTENT] placeholder.

[FOOTER]

The message footer

[SIGNATURE]
[SIGNATURE] prints the Blink Mailer image signature.

[FORWARDURL]

[FORWARDURL] is replaced with the personalised URL only. To use this, you
will need to wrap it in HTML, like this:

<a href="[FORWARDURL]">Forward to a Friend</a>

[PREFERENCESURL]

[PREFERENCESURL] allows the recipient to edit their subscribe preferences, for
example update their email or the number of lists they belong to. This
essentially allows them to maintain your list up to date for you and is an
invaluable feature.

[UNSUBSCRIBEURL] - a mandatory placeholder

[UNSUBSCRIBEURL] allows the recipient to totally unsubscribe from all your
lists. In Blink Mailer you must include this placeholder somewhere in your body
or footer. It is best to use this along side [PREFERENCESURL] if you manage
multiple lists, so subscribers can leave just one list rather than all lists if they
want.

Or 113
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[DOMAIN]

Prints your domain, e.g. yourdomain.com as listed in your configuration
settings.

[EMAIL]

Prints the subscribers email address.

Some older placeholders

These are some older placeholders which still work, but are not recommended
for use:

[FORWARD]

[FORWARDY] is a link where the recipient can go to “forward this message”. The
default text for this placeholder is this link.

For example, if you use "If you want to forward this message to a friend click
[FORWARD]", it will come out as:

If vou want to forward this message to a friend clicls this linlk

[UNSUBSCRIBE]

Like Forward the link that subscribers can use to unsubscribe. It will also be
replaced with "This Link", which means you can use it like this:

To unsubscribe from our newsletter click [UNSUBSCRIBE]
[PREFERENCES]

Like Forward and Unsubscribe the link that subscribers can use to update their
personal details and preferences. It will also be replaced with "This Link",
which means you can use it like this:

To change your preferences click [PREFERENCES]

DIY: Super simple template

We have made a very basic template for you to use. You will also need
*A version of your logo or similar image measuring 300px wide.

Download and save the template

Download the template by clicking here and then saving the file to your PC.

4
123
il
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Z
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https://s3.amazonaws.com/ph-manual/assets/basic-template.html

Upload the template to Blink Mailer

Go to Campaigns > Manage campaign templates.

r .

lates&delete=18&tk=16

scribers | Campaigns  Statistics  System  Config

Send a campaign

Info

MANAGE CAMPAIGN TEMPLATES

Mo template have been defined

Add new template | Add default system template

Give your template a name, for example My Newsletter Template. Then

click Browse.

My Mewsletter Template

have [CONTENT] somewhere.

file or paste the text in the box below

Browsk.. | No file selected.

I [ Format Normal

B 7 U iz =

| )

Select the file you downloaded earlier, called basic-template.html, from your

computer and click Open.

. BLINK
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Places

Desktop

[ File System
() SYSTEM_DRV
[ S |
phplist
Documents
B e

Music

e |

Name ¥ | Size Modified
[ et B 0" - 113.3 kB 22/06/14

N LT 113.3kB  22/06/14
[ s e aleei™s] .. 6.2 kB 01/09/14 |

[£ meareesmmallieml 666 bytes 09:20

Sl e Mes... 43.6 MB  17/07/14
[ el B 114.2kB 31/07/14
[ ol Bl EBElg=b.. 2.3kB  08/06/14

[ i i iam ... 60.0KkE  08/06/14 |
| All Files v |

Cancel | Open *_l

Then click Save Changes.

Check that all links have a full URL O
Check that all images have a full URL OJ
Check that all external images exist O

Save Changes

Upload your logo to Blink Mailer

You will then be directed to add your logo. Remember, it must be no more

than 300 pixels wide. Click Browse.

ADD OR EDIT A TEMPLATE

Images

Below is the list of images used in your template. If an image
database.

they will be included in the campaigns that use this template.

Image name logo.png (1 times used)
Mo Image was found

Upload new image: [ Bmwse*: | No file se

Save images |

This includes all images, also fully referenced ones, so you m

No file selecte

AFFORDABLE MARKETING SPECIALISTS
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Select your logo file from your computer and click Open.

File Upload

|2| | £ ”Em !! Documents  gingerling

logo_newsletter.png

1A

Places | Mame N

Q Search = logo_newsletter.png 4

@ Recently Used

= I
Deskto :
B ﬂj?y
L] File System “riing
[+ Ll | All Files ™ |
| Cancel ! | Open |

Click Save Images.

Make the template your default?

You will see your new template added to your list of existing templates. If you
will use this template for most of your campaigns, click the radio button

under Campaign Default.
Gy |

MANAGE CAMPAIGN TEMPLATES

Existing templates

EXISTING TEMPLATES D c T SYSTEM
P
My Newsletter Template 2 @)

All A Lk Aall i ™

Copy this footer text

<a href="[PREFERENCESURL]" title="Update your preferences">Update your
preferences</a> | <a href="[UNSUBSCRIBEURL]" title="Unsubscribe"

>Unsubscribe</a>

::: BLINK pg 117
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First go to Config > Settings.

nfig | Info

Configuration

Then scroll down till you find the Campaign Settings area.

| campaign settings
Default for 'From:' in a campal

Click the edit icon

G Default footer for sending a campaign

" |edit this value

=div class="footer" style="text-align:left; font-size: 75%">

=p=This message was sent to [EMAIL] by [FROMEMAIL]</p=

=p=To forward this message, please do not use the forward button of your email application, because this
message was made specifically for you only. Instead use the <a href="[FORWARDUFEL]">forward page</a=
in our newsletter system.<br/=

To change your details and to choose which lists to be subscribed to, visit your personal <a href="
[FREFERENCESURL]"=preferences page</a=<hr/=

Or you can <a href="[UNSUBSCRIBEUREL]"=opt-out completely=</a= from all future mailings.</p>=

=/div=

- SFEEEEETEEE R TR SRR TR R A R
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Delete the contents up to the -- and right-click to Paste in the html you copied
from this chapter.

—

gingerlinmﬁ)imrnhfnfi are

. Undo .
{when sending

| (:|_|E |

ginger Copy
I <. campaigns

No | Delete '

Select All

| ;when sending
2

" Check Spelling '
Languages >

Editing L ign
Inspect Element (Q)

Inspect Element with Firebug

Click Save Changes.

Save changes

Any new campaigns will now use this footer by default.

Using your new template

Compose a new campaign. In this example I have pasted the html from my
latest blog.
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SEND A CAMPAIGN

1

Content

content

subject €y

‘ Latest Blog: How to make a window-box from an old]CD rack

From line @

gingerling@inventati.org

content (1)
™ Send awebpage ® Compose message

Compose message @
iBsuce @A IB|IUICSICSIEESE

i)

- (&) Format

I am not a good gardener. | either don't do anything at all or | start over-large projects never g
leaving a wake of dead plants and weed filled containers behind me. But things have changed
small damp north facing yvard of my very own... so think it's time for me to have another go! Th
go-hero series of blogs will document my successes and failures.

Check that you are using your template by clicking Next and examining

the Format tab.

SEND A CAMPAIGN

2

Format

format

Send as @
HTML @ text ©

Use template @
My Newsletter Template :|

Save as draft ‘ Save and continue editing ‘

Send a test message using the Send test box at the bottom of the page.

BLINK
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Send test

Send test ‘ @to email address(es):

(comma separate addresses - all must be existing

Take a look at the email when it arrives. You will notice your logo displays
even when other, remote images are blocked, because Blink Mailer has sent it

as an attachment.

T =

rack

To M J‘:ﬁu’ﬂ*“-‘ﬂ I.]"':-' Other Actions™

To protect your privacy, Thunderbird has blocked

g remote content in this message, Show Remote Content |
Always load remote content from gingerling{@inventa...

Forward this message l

P B

And you can see your template has been applied,

A window box

| have been reading The Thrifty Gardner by Alys Fowler, a long-unread but 10/10
Christmas present from my parents. Having just bought a house | am pretty much broke
and her fun, practical and cheap/free gardening ideas are just the ticket. She
mentioned using an old CD rack for a window box, and | happened (o see one for a few
pounds in my local charity shop - CD's are going out of style so keep your eyes open for
these in skips, tips and charity shaps.

Strengthen the corners

Having ripped out all the plastic bits where the CD's ship into, | strengthened the
comers so the box will cope betier with the wet outside, | tried using little L-shaped
brackets but that didn't work because there wasn't enough space to drill/screw at a

sensible angle, so | (well, my other half Joey) just nailed it together a bit more. In

retrospect, | should probably have used screws instead - next time | will do this better.

BLINK
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Subscribe page design and
configuration

Subscribe page is the name of the page where your subscribers can join your
lists. You can have as many subscribe pages as you want, and you can make
them look like your website.

You can customise your subscribe pages in various ways. You can edit the default
design, which will affect all the pages, on your Config > Settings page, and/or
you can tweak the design of individual pages using the Header and Footer boxes
on the subscribe page editor.

Modifications from within the Config > Settings page

Go to Config > Settings from the main menu, and scroll down to the
subscription-ui settings area. Here you can edit the html of the pages, and also a
few basic settings.

Modifications from within the subscribe page editor

The Header and Footer boxes in the General Information section of Config >
Subscribe Pages > add/edit a page can be used to edit the HTML of an individual
subscribe page.

The html in these boxes is generated from the defaults in Config > Settings >
subscription-ui settings, which can also be edited (see above).

You don't need to use <HTML> <head> etc, as Blink Mailer already includes this
for you. However, you can add your own Meta Tags and CSS file links or your own
<scripts> just so long as all these extras are above the </head>.

If you create your own CSS styles for your page, save the file outside of the Blink
Mailer folder structure, for example in the stylesheets directory. Then add a rel
link to the new file above the </head> tag. Keeping it outside of the Blink Mailer
folder structure will make it easier to upgrade later on.

<link rel="stylesheet" href="/styles/customised.css" type="text/css" />

Advanced Customisation

You may wish to heavily customise your Subscribe page, to make it look like it is
part of your website (rather than third party software).

You should use a HTML editor for this task. You create a blank page in your HTML
editor, then copy and paste the contents of the Header box and replace the code
</head> <body> in the HTML editor with the copied code.

You will need to be careful with exactly how much you paste into the Header box
and whatever you do paste must fit within the <TABLE> below the <!-- Top table
starts

L] L
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Advanced campaign
statistics

This chapter covers

« The statistics menu

« Drilldown by campaign into clicks and/or opens
 Domain statistics

« Using a Google tracking code

« Forward to a friend.

Basic statistics, as found in the Statistics Overview, are covered in the chapter
called Basic Campaign Statistics.

The Statistics Menu

The statistics menu pulls together a lot of features. It is worth exploring what
can be found though this menu. The main items on the menu are Overview,
Opens, Campaign clicks, URL clicks and Domain statistics. You may also see
other options, for example Advanced statistics, if your statistics plugins is
activated.

To get a basic understanding of what data is available you can work
methodically from the top down, first viewing each page, then seeing what
links are provided in each page, and onwards. You will often come full circle.

Config  Info

In this chapter we will approach our drilldown from analysing one campaign,
covering both opens and clicks. You can also compare multiple campaigns, or
focus on a specific URL you are trying to drive traffic to. The approach you take
depends on the questions you are trying to answer.

Drilling down into an individual campaign

The starting point for an analysis of a single campaign is the campaign

A BLINK
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http://www.blinkmarketing.co.za/user_manual/basic_campaign_statistics.html
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statistics overview. This can be found in Campaigns > List of campaigns >
Sent Campaigns by clicking on the graph button.
[ Vi N T

b a ] 1E

The phpList Autumn 2014 survey 24 October 2014 Sent 2014-10-24 N |
14,0158 17:15:23 E

il riHi

b et derwrl. [E"1

and also by visiting Statistics > Statistics overview and clicking on the name of
the campaign.

STATISTICS OVERVIEWW

Download as S5V file

The phpList Autumn 2014 survey |

R el P ——— = .

Either of these routes will bring you to the Statistics Overview for a campaign.
The page gives you an overview of information and two ways to drilldown are
available.

|
The phpList Autumn 2014 survey
Subject The phpList Autumn 2014 survey
Date entered 2014-10-24 14:01:58
Date sent 2014-10-24 17:15:23
Sentas HTML 10143
Sent as text 27
Ivalid emall address 3
Sent 10169
Bounced 1533
Opened 2075 %
% Opened 24.03
Clicked 121
% Clicked L40
Forwarded a

BLINK
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Opened Drilldown

By clicking the humber of opens, you can get a a page called Open Statistics.

Bounced 1533
Opened __Q
% Opened 24,
2075
Clicked 12T
% Clicked 1.40

This page allows you to Download as a CSV file a list of those subscribers who
were registered as having opened the campaign (remember this is by no

means everyone, only those recorded).

The csv file can in turn be used to create lists of active subscribers, or by using
the list-exclude feature you can isolate inactive subscribers too.

subject  The phl Download as CSV file
Entered 2014-10-Z8 I3 0I50
Sent 2014-10-24 17:15:23

Open statistics

Listing 1 to 50 of 2075 Entries

DPENSTATETICS FRSTVIEW REZPONSETME

SENT-240CT 208 HAT: 12

C WAECETWE 26 Oct 2014 1522:32

SENT:-240CT 208 M47; 13

L=

SENT:240CT 2084 Me4T: 10

g B i 24 0ct 2014 16-48:24

mestoinlpieg 24 Oct 2014 14:56:53 11 minutes 33 seconds
SENT:240CT 208 BHA5:20

Eempilim: b 24 Oct 2014 15:19:24 32 minutes 12 seconds
SENT: 24 0CT 205 MeA7: 12

il gt .. 25 0ct 2014 12:24:41 21 hours 37 minutes 29 seconds

2 days 1 hours 35 minutes 19 seconds

e wwd- il 24 Oct 2014 17:14:13 2 hours 27 minutes
SENT:-240CT 208 BeAT:13
1 e ) 24 Oct 2014 16:03:09 1 hours 15 minutes 59 seconds

2hours 1ininutes 24 =aconds

You can also click on an individual subscriber
level.

QOPEN STETETICS

SENT: 24 OCT 204 4520

FIRSTVIEW
24 Oct 2014 145653

re [ 24 Oct 2014 15:19:24

BLINK
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This will take you to the Campaigns tab in the History section of the Subscriber
profile, where you can click further links to view the campaigns they have
opened (left) or the links they clicked on in that campaign (right).

You can also see the date on which they viewed a campaign and the response
time (in seconds).

Subscriber

Details

remave subscriber

12 messages sentto this subscriber

7 .

Messages
544
3544
3547
3548
3552
3553
3554
3556
3557
3558
3559

average

Campalgns { Subscription

[— T — R — T — B — RN — TR — TR — T — B — |

SENT
30 Mov 2010 17:24:21

15 Aug 2013 23:03:50
13 NDTZIJlS 21:45:13
27 Aug 2013 20:00:24
27 Aug 2013 22:00:55
13 Mov 2013 18:15:08
23 Jan 2014 18:00:21
22 Aug 2014 12:30:19
14 Oct 2014 10:15.09
24 Oct 2014 14:45:20
9 Dec 2014 17:45:10
30 Mar 2015 09:00:31

VIEWED

18 Aug 2013 15:07.04
15 Mov 2013 13:04.26

13 Nov 2013 18:18:27
23 Jan 2014 19:05:10
22 Aug 2014 13:18:06
14 Oct 2014 11:26:10
24 Oct 2014 14:56:53
10 Dec 2014 08:09:58
30 Mar 2015 09:21:58

RESPONSETIME

230594
141553

199
3889
2867
4261

693

51888
1287
48581

. BLINK
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can also choose to drilldown

Clicked Drilldown

In your campaign statistics overview page, you
into clicks data.

STATISTICS OVERWVIEWW
View all campaigns

The phpList Autumn 2014 survey

Subject The phpList Autumn 2014 4

Date entered 2014-10-24 14:01:58

Date sent 2014-10-24 17:15:23
Sentas HTWL 10143
Sent as text 27
Invalid email address 3
Sent 10169
EBounced 1533
Opened 2075
% Opened
Clicked
% Clicked

This will take you to a list of the links in that campaign, and how many people
clicked on each one.

BLINK
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Click details for a campaign

subject The phpList Autumn 2014 sunvey
Entered 2014-10-24 14:01:58

Date sent 2014-10-24 17:15:23

Sentto 10169 Subscribers

Bounced 1533 (15.08%)

clicks 120

click rate 1.39%

Campaign click statistics
CAMPAIG | CLE KETITETES
twittercom/phplist

TEXT:@ [HTML:-0
community.phplistcomi/users!
TEAT: L[HTML: L
facebook comiphplist

TEXT:@ [HTML:-0

hitpsiwwwuserweay ... 2e60b9d013
TECT8 [HTML: 16

www userwaave netisu . 2e60b9d013
TEXT:@ [HTML:-8

user-prompteom’

TEXT:@ [HTML: 1

CLEKS CLEK RATE
0 0.00%
LETESTCLEK: [FIRSTCLICK:
2 0.02%
LATESTCLICH: 21 ©CT20M 8.8 |FIRSTCLICK: M OCTOBER 2014 15:21.48
0 0.00%
LATESTCLICK: |FIRSTCLEK:
110 1.08%
LATESTCLICK: 31JAN201S 041 [FIRSTCLICH: MOCTOBER 2044 1A:43:54
8 0.08%
LATESTCLICK: 21 OCT 2054 M:34 |FIRSTCLICK: 34 OCTO BE R 2014 15:36 40
1 0.01%

LATESTCLICH: MOCTI0M B: 8 |FIRSTCLICK: M OCTOBER 201 18:13:06

tatal 121 1.19%

If you click on the url you can see how many people clicked on that url across
all campaigns which contained it.

b1 cy

clicks 120
click rate 130%

Campaign click statistics

CAMPAIGN CLIEK STATISTICS CLIEKES
twitter.com H:-Ii st ]
twitter.com/phplist
communityphplist 2
TEXT: 1 HTML: 1 LATEST CLICK:

L2
L]
[
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That data can also be downloaded as a csv.

) Iy Phad T 1 wsnd

Downlosd as CSV fils |

Click details for a URL http:/ftwitter.com/phplist

URL click statistics

UAL CLEKSTATETCS FIRSTELE K LATESTCLICK CLCHE  CLICK RATE
HewFralmr dilpia s Chel &l 30 Mar201512:47:48 30Mar201512:47 1 & | 0.01%

SENT: 1054
T g B ML el i 9 Dec 2014 18:25:18 9Dec 20141825 1 i| 0.01%
SENT: H0s o
AT ST A S 20 0ct2014 13:39:55 20 Oct 2014 13:39 1& 0.01%
SENT: 71830
L 1Y P R 22 Aug 2014 13:19:47 22Aug 20141319 1 a| 0.01%

SENT: 11207

Domain Statisics

The Domain statistics page is accessible from the main statistics menu and it is
a fascinating page which can give you real insight into the nature of your
subscribers.

Using a google tracking code

Using a Google tracking code ensures that any visits to your website from the
campaign are recorded in Google Analytics, if you have Google Analytics
tracking installed on your site.

Google tracking is quite different to the in-built Blink Mailer opens/views
tracking. Firstly the data is not collected, stored or viewed in Blink Mailer. Also,
if you link to another website in your campaign and if that website also has
Google Analytics tracking on their site (which is likely) then they also receive
data. In that sense the tracking code is not exclusive to you.

To turn on Google tracking for an individual campaign, click the add Google
Analytics tracking code in the Finish tab of the campaign workflow.

s
0
.
Z
A
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finish

email to alert when sending of this message starls
separate multiple with a comma

email address to alert when sending of this campaign has finished
separate multiple with a comma

@ add Gogygle Analytics tracking code
=

‘L' Reset click statistics

5
Finish

To turn on the use of tracking codes for every campaign, use the Always add
Google tracking code to campaigns in your campaign settings area, which can

be accessed from Config > Settings.

—[ campaign settings :I

Default for 'From:' in a campaign

Default for 'address to alert when sending starts’

Default for 'address to alert when sending finishes'

Always add Google trackingfpode to campaigns

[ 7 ] The default HTML template to use when sending a

AFFORDABLE MARKETING SPECIALISTS
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To view the data in your Google Analytics go to Acquisition > Campaigns and
you will see the name of each campaign.

» Custom
v Benchmarking 29,020 83.93
% of Tetal: 20.06% Ay fer View: 78.1
Users Flow {144,569 (7.4
i I 5,750 (19.84%) B7.7
Acquisition
t’ a| e 3,625 1z 45%) 86.4
Overview |
M| a 3,603 j12.42%) B1.6
v All Traffic
0] & 2524 (o) B6.9
v AdWards
i | Fn .
» Search Engine 5. 2085 aew) 65.2
Optimization | ]
O s ] 1,148 (z.38%) 855
v Social
M S
~ Campaigns . T 1,085 (z7a%) BB.2
All Campaigns Al e 991 (3.41%) B87.4
Paid Keywords M| g 873 [(po1w 91.0
Organie Keywords A | 10. 870 o0 2.8

Forward to friend

On your Statistics > Statistics overview page, the third column, FWDS, shows
the number of people who have forwarded the mail through the Blink
Mailer ForwardToFriend system.

This system uses a placeholder to create a link or form in the email body or
footer of your campaign for your subscribers to use to forward the mail to
someone else.

If your subscribers use this method to forward your campaign, any actions
(clicks, forwards etc) taken by the new recipient will be included in your
campaign statistics separately.

It is possible for you subscribers to forward the message by other means, but
you cannot reliably tell: any clicks or opens in an email which has been
forwarded without the Forward to a Friend system will be recorded as actions
of the original subscriber.

It is therefore worth including an option to forward the campaign, using
the [FORWARDURL] placeholder, in the header or footer. For example,

Footer (),

<p=1his message was sent to [EMAIL] by [FROMEMAIL|</p=
<p=To forward this message, please do not use the forward button of
your email application, beca made specifically for you

only. Instead use the <a hreg="[FORWARDURL]"-forward page=</a= in our
newsletter system. <br=

To change your details and to choose which lists to be subscribed to,

" - BLINK
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The subscriber will then see a forwarding link in the email footer:

To forward this message please do not use the forward button of your email
is message was made specifically for you only Instead use

padge
Or you can opt-out completelv from all future mailings.

& nhinl ict

When a subscriber clicks this link they are prompted to enter an email:

Forwarding the message with subject How to stay safe in the sun

Please enter a valid email address to forward to

test@example.com

Continue |

powered by phpList 3.0.6, © phpList ltd

. BLINK
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Scheduling

In the campaign workflow you will find the scheduling tab.

If you want to send a campaign straight away, and there is no need to stop
sending before a specific time, then you can leave these details unchanged and
your campaign will simply send.

If your needs are more complex, read on.

Scheduling tab

Below is an image of the scheduling tab. We we will work though it from top to
bottom:

1
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e@dday .
 Sending et C %
Yegq *8e -
Das
Scheduling help
A = Abo
scheduling BACK | NEXT it
Log
Dates and times are relative to the Server Time Sen
Current Server Time is 2015-03-31 09.55
List
Embargoed until )
a1 v || March v |[2015 v |[o9 ¥|[o0 ¥ =
tem
Stop sending after @
; Rec
7w || April ¥||2015 ¥ ||09 v (/00 ¥ v
Sen
Requeue every 1 Sen
-- o not requeue v
Requeue until eng
31 ¥ || March ¥|(|20l5 (|08 " | 0D¥
Save as draft Save and continue editing

Embargoed until

The campaign will not be sent until this time has passed. If you have a
campaign which you wish to send at a later date, perhaps when you out of the
office or away from your desk, then this is the feature you should use.

Embargo time is initially set to the nearest hour before you started your new
campaign: this effectively switches off the embargo feature by default. To use
the feature you must set the time in the future. Simply set the date and time
to the time you want to send, relative to your server time which is stated
above. Then place the campaign in the queue as normal. If you are using a
cron job then the campaign will automatically start sending at the desired
time.
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Dates and times are relative to the Server Time
Current Server Time is 2015-03-31 1644

Embargoed until @
3L v|[March v 2015 v |16 v | 00 ¥

04
Stop sending after @ gg
7 v || Apil v (2015 v || 0l [00 ¥
09
Requeue every @ | ﬂ
-- to not requeue 112

13
14
15

Requeue until
31 v | March

Save as draft

Stop Sending After

This feature is used when the topic of a campaign is time sensitive, for
example, a special offer with an expiration date or an event with a specific
time. If the campaign would become irrelevant to anyone who received it after
a particular time, then this is the feature you should use.

The primary use of this feature is when your list size exceeds your sending
capacity within the timeframe you need to send your campaign in. For
example, if you have a list of 10,000 subscribers and can send 1000 emails in
an hour but the campaign becomes irrelevant in 8 hours time, you need to
stop sending before everyone on your list has received a copy of the mail.

Re-Queue

The re-queue setting is used to send a campaign to subscribers who join a
list after the campaign is sent. Remember, a campaign will never be sent to
the same subscriber twice.
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Current Server Time is 2015-03-31 14:19

Embargoed until @
31 v || March ¥ 2015 ¥ | |14 ¥ ||00 ¥

Stop sending after @
7w April ¥ 2015 v | |14 ¥ ||00 ¥

Requeue every @
-- do not requede r

-- do not requeue
hour

week o Yy oo

[l L ﬁ.l =3 1 32 b as |

As an example, you create a monthly newsletter on the first of January, and
send it to a list. Over the month you expect another 50 people to sign up, or
be added to your list manually, and you would also like them to automatically
receive a copy of the campaign. You would set up your campaign to re-queue
every day and to re-queue until 31st of January.

Sending a web page

To send a web page rather than a message to your subscribers, log in to your
Blink Mailer admin pages, then choose to Send a Campaign Admin >
Campaigns > Send a Campaign

From this page, click on Send a New Campaign (or edit an existing Campaign).
In this example, I'll use Send a New Campaign.

6 phpList

Subscribers Campaigns Statistics System Config Info

SEND A CAMPAIGN

| start a new campaign J

start a new campaign

Choose an existing draft campaign to work on
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This results in:

From line (1)
‘ Head Gardener chair@ilkley]

LAY

© Send a webpage @ Compose message

Compose message @

l@Source|B D EI|EIH<H; e @mEE - "'Hq N R Y
R =N R N4
B I USXx| L

EE|C E PR E s S0 E

= m

Choose Send a Webpage rather than Compose message and you should see
this:

From line @

Head Gardener chair@ilkley

content (1)
@ send a webpage O Compose message

Send a webpage - URL (1)
http://dragonrider.co.uk

URL is valid
Footer @

‘ |

=div class="footer" style="text-align:left; font-size: 75%">

In the send a web page - URL box, enter the path of the webpage you wish to
send. Click outside the box and the URL is validated.

If you get this message, then check and double check that the page you have
entered actually exists. The URL does look correct, but the page does not in
fact exist.
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Head Gardener chair@ilkleygardeners.org.uk

Content @
@ send a webpage ' Compose message

Send a webpage - URL @
hitp:/faww. b lista.org/dem2._htm

Error fetching URL. Please verify that the URL entered is correct.
Footer (1),

=div class="Tooter" style="text-align:left; font-size: 75%"=
<p=This message was sent to [EMAIL] by [FROMEMAIL]</p=
«p=To forward this message, please do not use the forward button of your email application,

Once the page to be sent has been validated, simply select the template for
your message (optional), the list to which you wish to send to (required),
check that the embargo time is correct and send the campaign out.

Display Issues

Be aware that most email readers, especially those web-based ones
(Hotmail/Outlook, Gmail etc) will not show images by default, it will be up to
your subscribers to decide if they wish to receive images in emails by (usually)
clicking on a link in the email reader. Don't assume that your images will
automatically appear, so make sure your webpage includes ALT Text for each
image in your page when designed.

Sending plain text

Blink Mailer always generates a plain text version of your campaign, which is
then included in the html campaigns as a matter of course. This is part of the
normal working of email functionality. Blink Mailer also gives you two
additional features:

* Your subscribers can choose to receive plain text emails only
* You can edit the plain text version to improve it.

You can see the plain text version embedded in the source of your email by
clicking View Source in your email client (exact instructions vary wildly)

(-*_ C Ot Actio

Open in Convers]

Open in New Wir

F‘ phpLIS‘[ pen in New Tab)

Mark as Unread

Save as...

hpList 3.0.7 released - and a new manual i{  print...
he way!
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As you can see there is a plain text version in and amongst the html and other
code.

A-AnTlAbuse: Urlginator/slaller ULLYGLL - [22070 20730 7 147 1
X-Antidbuse: Sender Address Domain - uk-webspace.com
X-Get-Message-Sender-Via: camilla.lunarservers.com: authentics

--bl_63532a9c5d5458996c9e8chaad3a0baf
Content-Type: text/plain; charset=UTF-8
Content-Transfer-Encoding: guoted-printable

The phpList team is pleased to announce a new version of phpLi
3.0.7. To read the full story, please visit our blog here
<http://community.phplist.com/?p=301177=>

**¥Highlights**

Here are some of the more notable changes in the new version.
full list, please see the changelog
<https://mantis.phplist.com/changelog_page.php?version_1d=3054
**¥Edit a sent campalgn#*#

Back by popular demand 1s the option to edit a campaign that
or has been sent. To go into editing the campaign, you need tof
firet and won will find the 149nk to edit d4 =t the ton of the

Why edit the plain text version?

The automatically generated plain text version may not be very attractive. It is
good practice to provide a quality plain text version because it:

«displays better in some email software
*makes your emails more accessible for people with visual impairments.

To assess the state of your default plain text version, you can click to view
your emails only in plain text. In a desktop email client this is
usually View > Message Body As > Plain text.

L] llltm.‘ﬂ T Icﬂﬂ%t
=
| Headers > Tools
Message Body As > Criginal HTML ]
+" Display Attachments Inline Simple HTML
—
o T
Character Encoding >
Message Source Ctri+U
1

- BLINK
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You can then see your email as it would be displayed to someone who is only
able to receive plain text messages.

From admin <admin@phplist.org> o bR
Subject phpList 3.0.7 released — and a new manual is

To Me <anna@phplist.com> .0

Forward this message

<http://uk-webspace.com/test/pets/?p=forwardiuid=74
phplist.com <http://www.phplist.com/=

phpList 3.0.7 released - and a new manual is on 1
The phpList team 1s pleased to announce a new versy
the full story, please visit our blog here <http:/

Highlights
Here are some of the more notable changes in the ng

please see the changelog
<https://mantis.phplist.com/changelog paqe.phn?uer;

To improve this email and send a version formatted especially for these
subscribers only takes a few extra moments and, as you can see, provides a
much better quality of message.

The phplList team is pleased to announce a
3.0.7. To read the full story, please wisl
<http://community.phplist.com/?p=1177=

*¥*¥Highlights#**

Here are some of the more notable changes
full list., please see the changelog

<https://mantis.phplist. com/changelog_page]
**Edit a sent campalgn#*

Back by popular demand 1s the option to ed
or has been sent. To go into editing the ¢

first, and you will find the link to edit

=http:/fcommunity.phplist.com/wp-content/u

*#Send a web-page functionality update*#*

Enabling plain text editing

Some installations do not show the Text tab, which is used to manually
configure your text-only email content. If your tabs look like this, you'll need to
change the configuration:

SEND A CAMPAIGN

- BLINK
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To activate the Text tab in your installation, add the following lines to your
config.php file:

# Manual text part, will give you an input box for the text version of the
message

# instead of trying to create it by parsing the HTML version into plain text
define("USE_MANUAL_TEXT_PART',1);

instead of trying to create it by parsing the HTML wversion into plain text

Manual text part, will give you an input box for the text version of the message
efine( "USE_MANUAL _TEXT_PART',1);

An extra tab will now display in your campaign workflow.

SEND A CAMPAIGN

text

Plain text version of message 6))

Create your plain text version

Once you've created your HTML version in the Content tab (tab 1) click
the Next button.

LAY

Da.

hel

v -

Log

You should now be in the second tab, Text.

SEND A CAMPAIGN

Text

text

Plain text version of message (1)

You can manually compose the plain text version, or you can generate it
automatically by using the generate from HTML button. Some special
characters in your html email may cause this automatic generation to fail. You
can paste your text into this tab if you need to.

S BLINK
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generate from HTML

The empty Plain text version of message box will now contain a text only
version of your html message.

The content should be the same as the html version. However images in the
html version will automatically be removed and replaced by text descriptions
and urls are replaced by links. You can edit the message further if required, to
make it as attractive and legible as possible.

Once you are happy with your plain text version, click Save and continue
editing button, at the bottom of the text editing box, and carry on with testing
and sending your campaign.

When you send tests, you will receive two emails, one text and one html.

e 1=K 655
£:55 1655

F Plain Text = HTML ==ee=raa ==

| " Koply -Fwnlllmm e Junk | |metn

ﬂn.nprg = Forward lm—.nm' & ank @ Deler

Fram Ma <nfedqiothical-pets oo
Subiect Puuurfect S0X off Organic Cat Food (BB: 2008/14)
To M <rfcdethical-pets cous

war e Camd goue wsencia sl hean servanis |

OUred ACTsrd <

From Mo <infa@ethizal-pats. couksed
16:55 Subject Puwurfect: SOK off Organic Cat Food (BB: 20/8014]
To Me =infoipethical-pets.couk= 0

Cwar Cots [and vour sssocated buamen

16:5

Othar Atiana ™

S0z ms! ST WD

tme wil0y cuman Lyzes dl Lihizs] veis hese scoidentslly cosr-sincke
~arman Ergacic and M50 certafizd ooy cot Cops Ithz ore with Cis-oan Sood rews!

1l

Sorme glhy burar Teaes ok Ethical Pets hove
accidercaly ower-stackes Yerrzh Crgeric
ane M50 certifec dry ool focd dthe ore Witk
Tk in iy,

hrpm:'lts of deg sap: of chiz delocacy thet =re geitong nes-
“brst brfere zatz.” Towe zato. which 15 the 20t of dug.st
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nn e carcaging - oan e
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Format tab: ONLY send plain text?

On the format tab there is a radio button for sending in either HTML or Text.
Typically you will want to select the "HTML" radio button, which sends a
version of the message that each subscriber specified when they joined your
list.

However, if you want to send the text version of the message, select the
"Text" radio button. This will override the user preferences, and send all
subscribers the text version of the email.

-BLINK
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SEND A CAMPAIGN

3
Format

format

Send as @

. O[]

Save as draft | Save and continue editing

Bounce management

Introduction to bounce management

Whenever an email is sent via the internet, regardless of the email software
used, the email is transmitted by an MTA (Mail Transport Agent). In most
cases the MTA is the internet provider’'s SMTP mail server, sending to the MTA
of the email’s recipient, through intermediary MTAs.

If the email cannot be delivered to its recipient, the last MTA that tried to
transmit the email generates an error email, called a bounce message, which is
sent back to the sender’s email.

Usually, this bounce message contains a specific error code that explains why
your email could not be delivered to its recipient.

Blink Mailer implements bounce management which handles these bounce
messages, and provides automatic actions depending on the error code, like
removing an incorrect email address.

Advanced bounce management

Advanced bounce management enables the automatic performance of various
actions depending on the kind of bounce error code that is returned by the
MTA.

To enable it just add the following in config.php
define('USE_ADVANCED_BOUNCEHANDLING',1);

Once this is set up, you may proceed in the Blink Mailer interface
to System > Manage Bounces > List Bounces Rules
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MANAGE BOUNCES

View Bounces

View Bounces per list
Check Current Bounce Rules
Process Bounces

You have already defined bounce rules in your system. Be careful with generating new ones, because these may
interfere with the ones that exist.

Generate Bounce Rules

From there you may create new bounce rules, based on regular expressions
that will trigger Blink Mailer actions.

Regular expressions are sequences of characters that match a search pattern.
While this manual won't explain the use of regular expressions, we will analyse
the examples given here.

Bounce emails generally contain a header and a mail body that may,
depending on the MTA that sent the email, give a reason why the initial email
could not reach its recipient.

An example bounce email could look like the following:

Final-Recipient: rfc822; someuser@example.com

Original-Recipient: rfc822;someuser@example.com

Action: failed

Status: 5.2.1

Remote-MTA: dns; mxl.example.com

Diagnostic-Code: smtp; 550 5.2.1 This mailbox has been blocked due to
inactivity (UserSearch)

What we see here is the recipient’s MTA telling us that the user’s mailbox is
blocked, probably because it's not been used for a long while. There are some
excellent articles about MTA responses on the internet. Every MTA programme
has its own return messages. Also, you may have noticed that the return
messages usually come with a 3 digit code, 5.2.2 in this example.

This code is the error code corresponding to the return message, but some
MTAs just give bogus codes, especially when they think your email is spam.

Now let’s create our first bounce rule:
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BOUNCE RULES

Number of candidate rules: 18

[Acme ‘v

Mo Rules found

add a new rule

Regular Expression {This mailbox has been blocked due to inactivity)

action unconfirm subscriber [v]

Memao for this rule

Mailbox not in use anymore

Add new Rule

The regular expression could be the exact sentence the MTA return message
contained, in brackets.

Now Blink Mailer provides multiple actions that can be triggered if a bounce
email matches our regular expression:

» Delete subscriber

* Unconfirm subscriber

* Blacklist subscriber

* Blacklist email address

« Delete subscriber and bounce

« Unconfirm subscriber and delete bounce

« Add subscriber to the do-not-send list and delete bounce
 Add email address to the do-not-send list and delete bounce
* Delete bounce.

In our case, we can assume that our subscriber’s email address haven’t been
used for a long while, and that it's safe to unconfirm the subscriber.

Now we have a choice between “unconfirm subscriber” and “unconfirm
subscriber and delete bounce”. The only real difference between both options
is that deleting the bounce message will also remove it from bounce statistics
(using the BounceStatisticsPlugin).

Once we finished our rule, we may add it and try it against our bounces.

e
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Back in Blink Mailer, we can check if our rule matches any of our actual
bounces, by going to System > Manage Bounces > Check Current Bounce
Rules.

The system will then tell us how many bounces are caught by our rules.

Now you may have a big list of bounces that aren't caught by the rule, and
some of them are pretty similar to the rule.

We may have multiple bounce messages that could say “account is disabled”
or “This account has been disabled” which basically means the same as
“mailbox has been blocked due to inactivity” of our first rule.

Way may create two other rules to deal with these bounces, or improve our
regular expression to match all these messages with the same rule.

Regular expressions use the pipe symbol “|” as OR statement, meaning the
following regular expression:

(black|white) would match any text that has the words black or white in it.

Now let’s improve our first rule by adding all our MTA return messages that
basically mean the same thing:

BOUNCERULE

back to list of bounce rules

Regular Expression (account is disabled|This mailbox has been blocked due to inactivity|This
Created By admin

action | delete subscriber and bounce E

Status active E

Memao for this rule

User doesn't exist apymore -> delete user and bounce message
local delivery ary failed | is a permanent error accnrdlng to Exim

Save changes

The actual regular expression I used here is:

(account is disabled|This mailbox has been blocked due to inactivity|This
account has been disabled|The email account that you tried to reach does not
exist|This is a permanent error * local delivery failed)

Note that the * is a wildcard token that means there can be up to zero
characters between “This is a permanent error * and “ local delivery failed”.

This rule can now deal with any of these 5 return messages.
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Good starter rule set:

Number of active rules: 6
Number of candidate rules: 12

(e 8

Bounce Regular Expressions

BOUMCE EXPRESSION ACTION  #BNCS TAG ORDER DEL
REGULAR
EXPRESSIONS
rule 33 {User unknown|Unknown user|Unknown address|Mo such delete 3320 [ 1 Del
recipient|No such user]The email account that you tried to reach  subscriber
is disabled|Recipient not found|Recipient unknown|Invalid and
recipient]Address unknown|Recipient address rejected) bounce
rule 21 (sorry, no mailbox here by that name|Mailbox disabled|address delete | 667 |[] | o | Del
not found in table |User mailbox is not localmailbox not subscriber
allowed|Mailbox syntax and
incorrect| RESOLVER.ADR\. RecipNotFound) bounce
rule 6 (delivery error: dd This user doesn't have a yahoo fr account|This  delete 334 [] 3 Del
user doesn't have a yahoo.fr account) subscriber
rule 32 (account is disabled| This mailbox has been blocked due to delete 204 [ 4 Del
Inactivity| This account has been disablad|The emall account that  subscriber
wou tried to reach does not exist|This is a permanent error * local and
delivery falled) bounce
rule 43 (Archived recipient.) delete 91 (O||g |Del
subscribar
rule 48 (type=MX: Host not found) delete 6 [O||g |Del
subscriber

Rules to copy
(Archived recipient.) Delete subscriber

(delivery error: dd This user doesn't have a yahoo.fr account|This user doesn't
have a yahoo.fr account) Delete subscriber

(type=MX: Host not found) Delete subscriber. No mail records for the domain.

(sorry, no mailbox here by that name|Mailbox disabled|address not found in
table|User mailbox is not local|mailbox not allowed|Mailbox syntax incorrect|
RESOLVER\.ADR\.RecipNotFound) Delete subscriber and bounce. No ambiguity
here, we can also delete the bounce message.

(account is disabled|This mailbox has been blocked due to inactivity|This
account has been disabled|The email account that you tried to reach does not
exist|This is a permanent error * local delivery failed) Delete subscriber and
bounce. Same as above

(User unknown|Unknown user|Unknown address|No such recipient|No such
user|The email account that you tried to reach is disabled|Recipient not found|
Recipient unknown|Invalid recipient|Address unknown]|Recipient address
rejected) Delete subscriber and bounce. Same as above

A BLIN K

AFFOREABLE MARKETING 3RECIALIETS pg 147



	System overview
	What is Blink Mailer?
	A quick tour of Blink Mailer
	Campaigns
	Subscribers
	Subscribe pages
	Campaign Statistics

	What does Blink Mailer not do?
	Case Studies
	Large Business
	Medium Business
	Small Business 
	Community Group
	User Manual
	Aims
	Target audience and assumptions 
	Disclaimer
	How to use this manual
	Styles
	Documentation team
	Basic Usage.pdf
	Logging in
	Blink Mailer when you are logged out
	How to log in to Blink Mailer
	How to log out of Blink Mailer
	Adding your first subscribers
	How to get your first subscribers
	Create a list in Blink Mailer
	Add Subscribers to Blink Mailer by copy and paste 
	Check it out! 
	Asking and assuming permission
	Long term subscriber list health
	Sending your first campaign
	Schedule your campaign 
	Select your lists
	Sending your campaign
	Process your queue  
	Basic campaign statistics
	The statistics overview page 
	Sent
	Bounces
	Forwards
	"Views"
	An "open" is not always recorded.
	Still a useful statistic...
	What's the difference? 
	Rate 

	Summary

	Growing and using complex lists.pdf
	Understanding subscribers & lists
	What is a subscriber?
	What is a subscriber profile
	What is a list? 
	How to delete subscribers
	Creating your lists
	Go to your lists page
	Add a list
	Public List
	Category
	List Description 

	Adding subscribers to lists
	Why is (to lists) in brackets? 
	Copy and pasting Why and when to use this method 
	Upload a file with emails  Why and when to use this method 
	Data that includes an ID
	Renaming columns to avoid Blink Mailer system values
	Renaming columns to match Blink Mailer system values

	Importing the subscribers 
	Problems?

	Creating a subscribers page
	Create a page 
	Customise a Subscribe Page
	General information
	General Information: HTML or Text
	Transaction messages
	Select the attributes to use 
	Select the lists to offer
	Save your new page
	Use your page to add a subscriber as an admin 
	Setting up your list categories
	Categories before lists
	Lists before categories
	Create your categories 
	Add lists to categories

	Using your categories
	Using attributes
	Creating Attributes when importing data
	Creating and editing attributes on the Configure attributes page
	Example edit 1: changing the type from textline to select 

	Placeholders in Blink Mailer 
	Where to find a list of Attribute placeholders
	How to use a placeholder in a mail 
	Set up two test accounts
	Send a test message
	Check the results

	Adding a segmented list to Blink Mailer
	Sending to a segmented list
	Excluding a list
	Activate the list exclude feature 
	Using the list exclude feature

	Additional benefits of segmentation 

	Designing and assessing your campaigns.pdf
	CKEditor Interface
	Interface Structure
	Resizing and Maximizing CKEditor
	Using the Toolbar
	Collapsing and Restoring the Toolbar
	Editing Area
	WYSIWYG Editing
	Navigating the Editing Area
	Context Menu
	Elements Path
	Dialog Window Structure
	Reopening a Dialog Window
	Resizing a Dialog Window
	Working with a Document
	Text Styling
	The Templating Workflow in Blink Mailer 
	An infographic about templating in Blink Mailer
	
	The footer
	What is the footer?
	Adding your footer
	The Forward to Friend footer
	Creating a template
	Creating your template
	The Basics  
	Logo: upload or remote link?
	A mandatory placeholder in the body  
	[CONTENT]  

	Adding your template to Blink Mailer
	Name your template
	Save your template 


	Using your template
	Advanced templating

	More template placeholders
	[SUBJECT] 
	[CONTENT] - a mandatory placeholder
	[FOOTER]
	[SIGNATURE]
	[FORWARDURL]
	[PREFERENCESURL]
	[UNSUBSCRIBEURL] - a mandatory placeholder
	[DOMAIN]
	[EMAIL]
	Some older placeholders
	[FORWARD]

	DIY: Super simple template
	Download and save the template
	Upload the template to Blink Mailer
	Upload your logo to Blink Mailer
	Make the template your default?
	Copy this footer text
	Using your new template
	Subscribe page design and configuration
	Modifications from within the Config > Settings page 
	Modifications from within the subscribe page editor 
	Advanced Customisation
	The Statistics Menu
	Drilling down into an individual campaign
	Clicked Drilldown 

	Domain Statisics
	Using a google tracking code
	Forward to friend


	Sending.pdf
	Sending
	Scheduling
	Scheduling tab
	Embargoed until
	Stop Sending After
	Sending a web page
	Display Issues 

	Sending plain text
	Why edit the plain text version?
	Create your plain text version 
	
	Format tab: ONLY send plain text?
	Bounce management
	Introduction to bounce management
	Advanced bounce management
	Rules to copy




